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Introduction

Paragon Partition Manager™ Personal is an integrated set of powerful tools that is specially designed to tackle most of
the problems the user might face while using PC. A highly intelligent program engine together with built-in advanced
recovery facilities make it possible to securely carry out partitioning operations of any complexity, optimize

performance of NTFS and FAT file systems, migrate the system to another hard disk, etc. without fear to lose precious

data.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

JAN

Our company is constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

What's New in Partition Manager Personal

The latest Linux kernel to enjoy support of a wider range of hardware configurations, including the brand new
Intel ICH9 chipset.

More flexibility for online data processing techniques to provide for easier configuration for both, Paragon Hot

Processing and Microsoft Volume Shadow Copy Service (VSS).

Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows
native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit
Windows.

Better support for GUID Partition Table (GPT) to back up and restore not only single GPT volumes but entire
disks, including the option of resize during the restore operation.

Better support for the Apple Boot Camp Configuration with the option not only to back up and restore this kind
of configurations, but to copy single volumes or entire disks with resize.

Better support for Linux ExtFS starting from Ext2FS up to the brand new Ext4FS.

Product Components
In order to cope with different tasks, the product contains several components:

Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and
cloning, etc.

Linux/DOS based recovery environment is a multi-platform bootable media that enables to run utilities under

Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both
platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB
devices. It enables to burn CD/DVD disks. However there can be some difficulties with detecting new hardware.
DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment
requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP
like environment.
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Features Overview
This chapter dwells upon key benefits and technical highlights of the product.

Key Features
Let us list some of the key features:

User Friendly Fault Minimizing Interface
e Graphical representation of the data to gain a better understanding.

e A handy Launcher to easily find and run the required tasks.

e Comprehensive wizards to simplify even the most complex operations.

e Resize partitions directly on the Disk Map with the drag-and-drop technique.
e A context sensitive hint system for all functions of the program.

e Previewing the resulting layout of hard disks before actually executing operations (so-called virtual

operations).

Backup Facilities
e Support of basic techniques to store backup images:

- Backup to local mounted partitions;

- Backup to an external mounted storage to provide for a higher level of data protection and system
independence;

- Backup to a network drive to stand a better chance of success in case of a hard disk failure.

Restore Facilities
o Restore an entire disk, separate partitions or only files you need from the previously created backup image.

A Restore Wizard is only available for the Linux/DOS bootable recovery environment.

Copy Facilities
e Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap code and

other system service structures, thus maintaining the operating system’s working capability.

A Copy functionality can also be used as an alternative way of data protection.

Boot Management Facilities
e Boot Manager Setup Wizard to easily manage several operating systems on one computer.

Partition/Hard Disk Management Facilities

e Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the
standard Windows disk tools, the program supports all popular file systems.
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e Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it
to NTFS and then make it available in the system by assigning a drive letter.

e Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions
(NTFS, FAT16/FAT32), into a single, larger partition.

e Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated

space and the unused space of other partitions.

o Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an

adjacent partition of a hard disk (including partitions of Apple Boot Camp).

o NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and
interrupting its work.

e Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting.

e Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.

e Modify file system parameters (make active/inactive, hide/unhide, volume label).

e Install New OS Wizard to make a system ready to install a new operating system.

e Undelete Partitions Wizard to recover an accidentally deleted partition.

File System Optimization Facilities
o 27 defragmentation strategies available to defragment FAT and NTFS file systems.

e Safe Defragmentation Mode to guarantee data loss free defragmentation of any version of NTFS and FAT.

o Low free space defragmentation (less than 1% of the free space required) to successfully defragment almost full
disks.

Auxiliary Facilities
e File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD

as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to
replace corrupted data from a previously created image in case of an operating system failure.

A File Transfer Wizard is only available for the Linux/DOS bootable recovery environment.

o Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain an

operating system or just data. Volume Explorer will let you explore a file system of any type and provide access
to the necessary files and directories regardless of their security attributes.

e Recovery Media Builder to create a bootable recovery media based on Linux/DOS on a CD, DVD disc, or flash
memory, which can later be used to boot and recover your computer in case of an operating system failure.
Moreover, with its help you can save data from partitions of your hard disk directly to compact discs or burn
ISO-images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R,
DVD+R double layer, Blu-ray and can handle multi-session burning.
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o Network Configuration Wizard to establish a network connection under Linux either to save a backup of a
partition/hard disk or just several files on a network computer or retrieve a previously made backup from a
network computer for recovery purposes.

e Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or
a boot virus activity.

A Boot Corrector is only available for the Linux/DOS bootable recovery environment.

Supported Technologies
Along with using innovative technologies from outside, Paragon has developed a number of its own original
technologies that make its products unique and attractive for customers:

e Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

e Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power
outages or an operating system failure.

e Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

e Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and
interrupting its work.

e Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity.

e Paragon BTE™ technology to set tasks for execution in the Windows blue screen mode, thus saving from the
need to use a bootable media when modifying system partitions.

e Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

e GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.

Supported File Systems
e Full read/write access to FAT16/FAT32 partitions.

e Full read/write access to NTFS under Windows 95/98/ME, Linux and PTS DOS. Compressed NTFS files are also
supported.

e Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions under all versions of Windows, DOS 5.0 and later.

e Limited read/write access to Apple HFS+ partitions.
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Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at
the moment. The company is about to implement it in the nearest future.

Supported Media
e Support of both MBR and GPT hard disks (up to 1,5 TB tested)

IDE, SCSI and SATA hard disks

CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs

FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks

PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

Distribution
Paragon Partition Manager Personal is distributed in two ways:

e Boxed package from Paragon Technology GmbH and resellers
e Downloadable package over the Internet at the company’s web-site

Distributive CD
The boxed package includes a distributive CD that is in fact a bootable Linux/DOS recovery environment with auto-run
of the Windows installation, thus it can be used as a ready-made solution (see Booting from the Linux/DOS Recovery

Media). But if you're going to run the Windows components, you need to install them first (see Installation).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package
as described in Online Distribution).

Online Distribution
Partition Manager Personal purchased over the Internet will be in form of an MSI package. After installing the product
you can launch the Recovery Media Builder to build the Linux/DOS recovery media.

Registration
Paragon Technology GmbH provides a wide range of online services through its web-portal - www.paragon-
software.com/support/:

e Registration of new users;
e Registration of purchased products for registered users;

e Available around-the-clock downloading center, where registered users can get product updates/upgrades as
well as all the necessary documentation;

e Downloadable free demo versions and open documentation for all users.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
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A It is recommended to use Internet Explorer 5+ or any compatible browser.

To register as a new user
To register as a new user, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Click Create of the Create a Paragon Account section;
3. Fill out a registration form;
4. Click Register.

The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access
password will be sent to this address as well.

To register a new product
If you are a registered user and would like to register Partition Manager Personal, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Inthe Email field of the Authorization section, enter an E-mail used for registration;
3. Inthe Password field enter a password received after registration;

4. Click Sign in;

5. If the user name and password are valid, you will get to your account;

6. Click Register new product of the Products section;

7. Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from
your reseller. Click Next;

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish.

That is all. The product is now registered.

How to Download Updates/Upgrades
Downloading of updates/upgrades can be fulfilled in the following way:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Inthe Email field of the Authorization section, enter an E-mail used for registration;
3. Inthe Password field enter a password received after registration;

4. Click Signin;

5. If the user name and password are valid, you will get to your account;

6. Select My Downloads of the Products section to see what updates are available for you;

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
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7. Select the desired update and click Download.

Contacting Paragon Technology GmbH
If you have any questions about the company products, please do not hesitate to contact Paragon Technology GmbH.

Service Contact

Visit Paragon GmbH web site WWW.paragon-software.com

www.paragon-

Registration & updates web-service
software.com/support

Knowledge Base & Technical Support kb.paragon-software.com

Pre-sale information sales@paragon-software.com

System Requirements

Windows based set of utilities
To use the Windows utilities, you should install them first. But before that, please make sure your computer meets the
following minimum system requirements:

e Operating systems: Windows 2000/XP/Vista/7 and XP SP2/Vista/7 64-bit

Internet Explorer 5.0 or higher

e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 128 MB of RAM (256+ recommended)

e Hard disk drive with 440 MB of available space

e SVGA video adapter and monitor

e Mouse

Linux/DOS based recovery environment
To use the Linux/DOS recovery environment on your computer (it doesn’t matter what operating system is installed),
please make sure that it meets the following minimum system requirements:

e IBM AT compatible computer with i486 or higher CPU
e 256 MB of RAM

e SVGA-compatible monitor

e Mouse (recommended)

Additional requirements
There may be additional requirements if you want to use advanced features:

e Network card to send/retrieve data to/from a network computer

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
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e Recordable CD/DVD drive to burn data to compact discs
e External USB hard drive to store backup data.

Installation
As we have already mentioned only Windows components of the product require installation. So to install Paragon
Partition Manager Personal under Windows, please do the following:

1. Run Setup Application. Click on the *.MSiI file. This application will guide you through the process of the
program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to
continue.

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also
be printed out.

4. Provide Registration Information. On the Registration page you are to provide your product key and serial
number.

5. Provide Customer Information. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C:\Program Files\Paragon Software\Paragon Partition Manager Personal. To select another folder, click the
Change... button.

After you have selected the required folder, click the Next button to continue.

Do not install the program on network drives. Do not use Terminal Server sessions to install
and run the program. In both cases, the program functionality will be limited.

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



12

kernel mode hotcore driver, thus the system reboot is required to complete the installation

2 To accomplish online backup/copy of locked partitions/hard disks the program uses a
procedure.

First Start
To start Paragon Partition Manager Personal under Windows, please click the Windows Start button and then select
Programs > Paragon Partition Manager™ Personal > Paragon Partition Manager™.

The program provides wide opportunities in the field of hard disk structure modification, so
just to be on the safe side, please make a backup of your data before carrying out any
operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.

u@ Paragon Partition Manager™ 11 Personal Edition <"‘
Paragon F_’ar’qﬂon Manager ' S‘
Personal Edition

Partitioning Partitioning
What would you like to do?

Copying and
- i | # Create Partition

S Migration é
B \ Create a new parition and set its propedies
~—— Backup and Rescue » Delete Partition
- Delete existing parition and all data &t contains.
! Boot Management » Resize Partitions
o . Move border of adjacent paditions of the same type (both logical or both primary)
to redistribute space between them. Note: this wizard covers only basic resize
scenanos, f resize operation canl be camied out with Express Resize Wizard,
7. 41 please switch to Partition Manager man launcher. right click on a partition you
’é Partition Manager would like to resize and select "Move/Resize Parttion”,
Q Merge Partitions
Support Contacts Merge two adiacent patttions with the same file system and the same type (primary

to pamary or logical to logical).

© Help

To start up the traditional Launcher, please click the Partition Manager button and then
A Partition Manager.

To know more on how to handle the product’s interface and accomplish typical operations,
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please consult the Windows Components chapter.

Booting from the Linux/DOS Recovery Media

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your
hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-
standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only
basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup
To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

2 on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. lLaunch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

4. Consult the help system by pressing ALT+F1 to know more on the subject.

Boot menu
The Boot menu contains the following commands:

-« Normal Mode Hain recouvery

& Safe Mode enuvironment
& Low-Graphics 3afe Mode

= Floppy disk

& Hard disk 8 HMER

& Find 0Ses on your hard disks

e Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);

e Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it
fails to work properly;

e Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be
included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;

o Floppy Disk. Reboot the computer from a system floppy disk;
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Hard Disk 0. Boot from the primary hard disk;

Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating
system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the recovery environment you might experience some inconvenience

c caused by possible video artifacts. It is just a result of changing video modes and in no way

will affect the program functionality. If this is the case, please wait a bit and everything will
be OK.

Normal Mode
When the Normal mode is selected, the Linux launch menu appears:

»oF£F

!

00" B0 Bs6

You can create, delete and format hard disk

Paragon Partition Manager™ partitions wsing Faragon Partition Manager™,
which will stan now. Upon the stan, please
Restore Wizard select the drive and one of its partitions or its

free space. Then actvale the Pantition’
_ _ pull-down menu and select one of the
File Transfer Wizard partitioning operations.

Boot Corrector

Metwork Configurator

Log Sawver

View the mounted partitions
Stan the command line
Eject CD/DVD

Reboot the compuier

Power off

Partition Manager (enables to copy and back up separate partitions or entire hard disks, carry out partitioning
operations, etc.);

Simple Restore Wizard (allows restoring hard disks and partitions);

Express Resize Wizard (enables to increase free space on one partition by up-taking the unused space of an
adjacent partition);

File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to
CD/DVD);

Boot Corrector (helps to correct the Windows System Registry without Windows being loaded);

Network Configurator (enables to establish a network connection under Linux);
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If you are going to use network resources, first launch the Network Configuration Wizard to
establish a network connection.

e Log Saver (helps to collect and send the necessary log files to the Technical Support);

e View the mounted partitions (the list of all mounted partitions will be displayed);

The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in

different drive letters from Windows.

Eject CD/DVD;
Command Line (allows experienced users to execute any operation);

A DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have
[ ]
[ ]
e Reboot the computer;

[ )

Power off the computer.
To move within the menu, please use the arrow keys of the computer keyboard.

Safe Mode

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the
Normal mode except the Network Configurator and Log Saver commands. Besides due to certain limitations of the PTS
DOS environment, there is no possibility to burn CD/DVD discs.

Low Graphics Safe Mode
When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks
similar to the Safe mode but graphically simpler.

g Partition Manager 11 You can create, delete and

# Sinple Restore Hizard format hard disk partitions
HE File Transfer Hizard using this program, which
& Boot Corrector will start now.

Upon the start, please
M Start the command line zelect the drive and one of
# Reboot the computer its partitions or its free

space. Then activate the
'Partition’ pull-down menu
and select one of the
partitioning operations.

Basic Concepts
This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general
notion of the operation performance and makes it easier for the user to operate the program.

System and Data Protection
The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a
person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its

malfunction. So how this tragedy can be prevented?
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Backup Storage
Our program supports basic present day techniques of storing backup images. Let’s take a closer look at them all to
understand what kind of storage is able to provide better security:

e You can place a backup image to a local mounted partition. Despite the fact that it is the most convenient way,
try not to use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or
a virus attack;

e You can place a backup image to an external mounted storage to provide for a higher level of data protection
and system independence;

e You can place a backup image to a network drive to stand a better chance of success in case of a hard disk
failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it.

Paragon Hot Processing & Volume Shadow Copy Service

Offline versus Online Data Processing
In the course of time there have been developed various methods of data processing. Despite different work concept,
all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating
system and all the applications are completely shut down). Actually it is the most preferable way of image creation or
data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating
efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production
environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is
particularly useful for systems with high availability requirements, but it won’t be accomplished until all active
transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process,
taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast
high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers
its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft
VSS framework.

Paragon Hot Processing Technology
Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed
back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online
copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of
applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup
procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in
the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the
overall system performance, but a few kilobytes of the system memory.

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.
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It is not recommended to use Paragon Hot Processing with active SQL Server, Exchange or
Oracle databases since the backup image contents may be corrupted.

Volume Shadow Copy Service

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-
time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading
copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as
virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility
starts processing the data while applications keep writing to original volumes.

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of
multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange
2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of
database performance and reliability, thus providing 100-percent data consistency.

A To use VSS it is necessary to have a mounted 300 MB+ NTFS partition.

GPT versus MBR

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the
old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC
BIOS, it offers a number of crucial benefits:

e Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
e The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
e More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;

o A well defined and fully self-identifying partition format (data critical to the platform operation is located in
partitions, but not in un-partitioned or hidden sectors as this is the case with MBR).

Apple Boot Camp

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-
based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate
partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your
disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system
to start up.

It is strongly recommended not to modify the hard disk configuration with Windows Disk
Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and

A inability to boot in Windows XP/Vista. Please use our program to correctly update both
MBR and GPT.
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64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations of
very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more
simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory
allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor.
With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they
use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the
database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-
level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged
support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Copy Operations

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it
can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy
utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system
service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user
can get the system back on track in minutes. No additional configuration is required, what is very convenient.

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles
every two years, thus opening up new possibilities for software developers. As a result programs become more
complicated and require considerable amount of free space. One day the user realizes that there is no more free space
left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk,
the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided
just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up
similar computers. There is no need for a system administrator to install an operating system from scratch on every one
of them. It is enough just to configure one and then clone it to the others.

Drive Partitioning

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up
and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the
entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity
hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD
images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective
data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its
work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard
drives, but there is an easy solution — drive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
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operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing
video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-
fragmentation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue — in case of a system malfunction,
you can get the system back on track in minutes by recovering it from a backup image located on the other partition of
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the
Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundaries of each OS.

Windows Components
In the given section you can find all the information necessary to successfully work with the Windows version of the
product.

Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program
can be tackled by reading this very chapter.

General Layout
When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and
functionality:
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9. Legend Bar

10. Status Bar

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them
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to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

Main Menu

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

MENU ITEM

FUNCTIONALITY

Tools

View Log Files

View logs on the carried out operations

Send Log Files

Compress and send the log to the Paragon Support Team

Setup Boot Manager...

Manage several operating systems on one computer

Recovery Media Builder...

Restore the system even when the current operating system cannot boot

anymore
Settings... Edit the general settings of the program
Exit Exit the program

Changes

Undo “the last virtual
operation’

Cancel the last virtual operation on the List of Pending Operations

Redo ‘the last virtual
operation’

Cancel the last undo virtual operation on the List of Pending Operations

View Changes...

Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations
Reload Disk Info Refresh the current information about disks

Wizards

Express Create Partition...

Create an NTFS partition and make it ready for work

Create Partition...

Create a partition of any file system

Format Partition...

Format a partition of any file system

Delete Partition...

Delete a partition of any file system
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Express Resize Partitions...

Increase free space on one partition by up-taking the unused space of an
adjacent partition

Undelete Partitions...

Recover an accidentally deleted partition

Merge Partitions...

Merge adjacent partitions of NTFS, FAT or FAT32 file systems

Redistribute Free Space...

Redistribute available disk space of existed partitions

Install New OS...

Make your system ready to install a new operating system

Back up Disk or Partition...

Create a sector-based archive of an entire hard disk or separate partitions

Copy Hard Disk...

Create a hard disk copy

Copy Partition...

Create a partition copy

Hard Disk
Update MBR Update MBR (Master Boot Record) of the selected hard disk
View Sectors... View sectors of the selected hard disk

Properties...

Get in-depth information on the properties of selected hard disk

Partition

Create Partition...

Create a partition

Format Partition...

Format a partition

Delete Partition...

Delete a partition

Move /Resize...

Move/Resize the selected partition

Convert File System...

Convert file system of the selected partition

Assign Drive Letter...

Assign drive letter to the selected partition

Remove Drive Letter...

Remove drive letter for the selected partition

Hide Partition...

Make the selected partition unavailable for the operating system

Unhide Partition...

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition non-bootable by default

Change Volume Label...

Change volume label of the selected partition

Make Partition Primary...

Make the selected partition Primary

Make Partition Logical...

Make the selected partition Logical
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Test Surface...

Test surface of the selected partition/block of free space

Check File System
Integrity...

Check the selected partition for possible file system errors

View Sectors...

View sectors of the selected partition

Properties...

Get in-depth information on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location Select whether the Disk Map will be located on the top of the main window or
at the bottom
Help
Help Open the Help system (you can also do it by pressing F1)
About Open the dialog with information about the program
The Main Menu contents available at the moment may vary depending on the selected
object.
Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

&0

partition

Create an image of a hard disk or

éa

Resize two adjacent partitions

I@l:i Copy a hard disk
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a Defragment the selected partition

@ Open the Help system

Virtual Operations Bar
The program supports previewing the resulting layout of hard disks before actually executing operations (so-called

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALITY

[é:') Cancel the last virtual operation on the List of Pending Operations
C’i‘\ Cancel the last undo virtual operation on the List of Pending
Operations

Display the List of Pending Operations

,\N(Q Launch the real execution of virtual operations

% Cancel all virtual operations on the List of Pending Operations

Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance to
weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following window:

A i There are unsaved changes.

Please use & Apply command to commit them and % Discard command to
pemmanently undo the changes.

You can view changes history via . View Changes cgmmand and temporaty
undo ot redo the operation by means of ‘9 Undo and " Redo commands.

[] Dont show this notification again

Common Tasks Bar
The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's
wizards.

The bar contains several tabs named Basic Partitioning Tasks, Advanced Partitioning Tasks, Copy and Migration Tasks,
Backup Tasks, Tools and News and Documentation. Each of these contains a separate button bar which can be folded
by clicking it.
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Basic Partitioning Tasks

@ Express Creat Starting the Express Create Partition Wizard to create an NTFS partition and make
- ress Lreae

it ready for work.

Starting the Create Partition Wizard to create a partition of any file system.

Q._g' Create Partition

Starting the Format Partition Wizard to format an existing partition to one of the

@7;-‘@7 Format Partition .
file systems supported by the program.

%& S Starting the Delete Partition Wizard to delete a partition of any file system.
elete Partition

Advanced Partitioning Tasks

=) Starting the Express Resize Partitions Wizard to redistribute free space between
sk Express Hesize

Tz

two adjacent partitions.

Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, FAT,

._f_":
= M Partiti
ILT? SIeE TErHers FAT32 file systems.

7= Starting the Redistribute Free Space Wizard to redistribute available disk space of
=57 Redistrbute Free Space L. .
existing partitions.

:{} Starting the Undelete Partitions Wizard to recover accidentally deleted partitions.
g Lndelete Partitions

Copy and Migration Tasks

= Starting the Copy Hard Disk Wizard to copy a hard disk.
Egﬂ Copy Hard Disk g ad Py

£ Starting the Copy Partition Wizard to copy a partition.
= Copy Partition

Backup Tasks

= Starting the Sector Backup Wizard to create an archive of a hard disk or separate
é#—., Back up Disk ar Partition .
partitions.

Tools

& _ Starting the Boot Manager Setup Wizard to easily manage several operating
= Boot Manager Wizard
systems on one computer.

& st rew 05 wizard Starting the Install New OS Wizard to install a new operating system.

Help and Documentation

C ) Launching the help system (you can also do it by pressing F1).
\? Partition Manager™ Help
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fﬂﬁ Opening the page which contains information about the program. This page will
\_J About Partition Manager™ . .
be displayed in the Explorer Bar.

Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map
Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with
rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the
file system of the appropriate partition.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev) -

Local Disk (C:)
4395 GB NTFS

Large-sized bars display the following information about physical disks:
e Manufacturer,
e Model.

Small-sized bars display the following information about logical disks:
e Serial number,
e Drive letter,
e Total size,
o File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program
offers to choose from several types of the disk layout scaling. It's done especially to increase the program usability. For
instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk
layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution — linear scaling with the minimal limit to small partitions. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

v Linear
Linear Scaling Min Width
Loganthmic Scaling
]

=

Lirnex Exta ReizerFS

Copyright© 1994-2010 Paragon Software Group. All rights reserved.




27

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The drag-and-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar
The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

e The help system;
e General information on the product including its name, version and a list of helpful links;
e Detailed information about disks selected on the Disk Map;
e Volume Explorer utility.
According to these categories the Explorer Bar has several tabs:
e Disk View, which offers the user the following options:
- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions;

- Volume Explorer to browse and export contents of the selected partition/hard disk;

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form.

You can switch between these three components by clicking tabs on the left side of the
Explorer Bar.

e Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

"t:’!-’ Return to the previously browsed
) page
@ Open the next browsed page

Stop loading the current page

%
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Refresh the contents of the current
page

Partition List

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,

- Volume label (if exists),

- Partition type (Primary/Extended /Logical),
- File system type,

- Size,

- Amount of used and unused (free) space,
- Start/End cylinder,

- Start/End head,

- Start/End sector

- Free size in sectors/bytes

- Active/Inactive attribute

- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.
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By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change
its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:

Disk Map
Basic Hard Disk 0 (WVMware, VMware Virtual 5 SCSI Disk Dev)

Local Disk (C:)
39.9GB NTFS

Properties Bar
The Properties Bar provides information on the selected at the moment partition/hard disk:

For a hard disk

e Model,

e Serial number,

e Type of hard disk (basic or dynamic),

e Total size (in GB),

e Information on geometry of the disk (amount of sectors per track, heads and cylinders).
For a partition

e Drive letter assigned to the disk,
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e Volume label (if available),
e Type of the logical disk,
e File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).
Besides you can modify practically any partition property by clicking on the required value.

Legend Bar
The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the

Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32,
- NTFS,
- Linux Ext2/3/4,
- Linux ReiserFsS,
- Apple HFS.

Status Bar
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you need.
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General Options

9, Edit settings |7 |
Backin Sacs ceins 5 General options
Copy and backup options
Hot processing options [V Enable data loss protection
CD/DVD recording options Choose this option to ensure that no data will be lost f system unexpectediy
Parttioning options goes down (because of power shortage etc )
Operation dependency options [ Enable Inttial Backup reminders
Vetual mode options Choose this option to enable Intial Backup remindess. Intial Backup
Fie system conversion options guarantee the safety of your data by backing up all on-disk information
E-mail options nciuding standard bootstrap code and other system service structures before
Defragmentation options performing any critical partitioning operation,

0K ___}|  Cancel

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

e Enable data loss protection. Mark the checkbox to make the program work in the fail-safe mode (also referred
to as the data-loss protection mode), which ensures reliability for operations by maintaining a special journal. In
case of a hardware malfunction, power outage or an OS failure happened in the middle of a data-sensitive
operation (resize, move, merge, redistribute, change cluster size, etc.), the program will ask to insert the
bootable recovery media and automatically complete the interrupted operation, thus reviving the corrupted
partition.

A It is strongly recommended to enable this option.

e Enable Initial Backup reminders. If this option is marked, the program will automatically offer to make a backup
before accomplishing any critical partitioning operation, thus minimizing the risk of data loss.
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Partitioning Options

9, Edit settings (7 =
General options . T -
Bockain taaas coliios { @ Partitioning Options
Copy and backup options
Hot processing options [T Enable 64 KB clusters for FAT16
CD/DVD recording options Choose this option to enable 64 KB clusters for FAT16 partitions. With this
setting. you will be able to create FAT16 partitions with capacity up to 4 GB.

Operation dependency options Please note that only Windows NT family systems wil be able to access
Virtual mode options such partions.
Fie system conversion options Confimations

E-mai options [V Ask for volume label before partition delete
Defragmentation options
[~ Ask confimation when converting FAT 1610 FAT32

OK Cancel

This section contains a set of options that will be taken into account during partitioning operations:

e Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

e Request confirmation before partition deletion. Mark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

e Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.
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General Copy and Backup Options

far — B

et Ea~}
Backin Mage ouiods $ General copy and backup options
Copy and backup options
Hot processing options [T Partiion raw processing
CD/DVD recording options Copy/Backup each partition sector by sector. All sactors will be processed
Parttioning options one by one {even unused sectors). Requires more time to complete the
Operation dependency options operation.
Virtual mode options .
Fie system conversion options - Perfotml B opy
E-mail options This option is intended for copying only changes on the hard disk since a
Defragmentation options previous copy operation. The program performs comparison between 3

previous copy of the hard disk and s cument state. Only sectors that are
diferent will be written to a new copy.
[V Skip OS audiary files.

Choose this option to skip OS awdiary fles (ke pagefile sys. hbberfi sys etc ).
This wil reduce operation time and backup image size.

OK Cancel

This section contains a set of options that will be taken into account during copy and backup operations:

e Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

o Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.
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Hot Processing Options

S, Edit settings [-7 [

General options . )
Backup image options % Hot processing options

Copy and backup options

¥ Enabl hot processng

CD/DVD recording options

Hot processing technology
Parttioning options
Operation dependency options | Microsoft Volume Shadow Copy Service ~|
Virtual mode options Microsoft Volume Shadow Copy Service is a relisble technology designed
Fie system conversion options to back up volumes being locked by numerous active transactions of VSS
E-mail options supporting applications. Microsoft VSS technology requires over 300 MB
Defragmentation options of free space on any mounted NTFS volume for temporary data. This

technology is provided for Windows XP and newest Windows versions,
but unavailable for old versions of Windows (S8/ME/NT/2000)

Addtional options
" Aways use hot processing
(¢ Use hot processing only when partition is locked
Hot processing temporary drive;
[c =]
Number of attempts to start VSS: 3 5
Timeout between attempts fn seconds): [120 <
[V Switch between Hot Processing technologies

OK Cancel

In this section you may configure the hot processing mode:

e Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

e Hot processing technology. From the pull-down list you can select the required hot processing technology.

e Always use hot processing. Select the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

o Use hot processing only when partition is locked. Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once
you start any operation on a partition in this mode, it will automatically be locked by the program, thus you
won't be able to keep working with it as usual.

e Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot
backup data (by default — C:).

e Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a special boot-up mode.

o Timeout between attempts (in seconds). Here you can set a time period between different attempts to start
Microsoft VSS.
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o Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot
Processing and Microsoft VSS if one of them is unavailable at the moment.

E-Mail Options

>

9, Edit settings |2 (s
General options B = - ,
Backup image options E-mail options
Copy and backup options
Hot processing options Specify your e-mail account options:
CD"DVD recording options Outgoing mail server (SMTF): [——
Parttioning options
Operation dependency options  User e-mail address:
Virtual mode options l-—
Fie system conversion options SMTP port number. 2
¥ My outgoing server requires authentication
Defragmentation options
User name: [
Password: I
Specify e-mail notification oplions:
V¥ Send E-Mail notfication on apply
To: r
[T Send mail in HTML format
[T Send complete report after applying operations
[T Send graphical view of the disk sub-system before and after apply
Select the operations you would like to be notfied about
OK Cancel

This section contains a set of options that will be taken into account during the Send log files and Send e-mail
notification operations:

e Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to
a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the
SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a
traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. XXX.XXX.XXX.XX).

e User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or
organization's e-mail administrator.

e My outgoing server requires authentication. Activate the option to allow the program to make authentication
on the server before sending messages.

- User name. Enter the name that will be used to log in to the e-mail account.

- Password. Enter the password that will be used to access the mail server.
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Virtual Mode Options
& Edit settings R =
General options ﬁ .
Backip buage ocf Virtual mode options
Copy and backup options
Hot processing options r~Operations mode
COVDVD recording options ¥ Allow vitual mode
Parttioning cptions Set this option on to camy out all the operations virually, You will be able
Operation dependency options to commit the changes or rollback all of them or the last one. if you
switch this option off, the operations wil be camied out immediately.
Fle system conversion oplions
E-mail options [T Oose prograss dialeg automaticalky
Defragmentation options Set this option on to automatically close the progress dialog after committing
the changes

0K Cancel

In this section you may configure the virtual mode:

e Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enable this mode.

e Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after
accomplishing operations.

File System Conversion Options

% Edit settings f?_, )
Bckiip Minos dalli File system conversion options
Copy and backup options
Hot processing options Select a time zone:
CO/DVD recording options | (GMT) Greenwich Mean Time: Dubin, Edinburgh, London. Lisbon ~|
Parttioning options
Operation dependency options  Select language for file names:
Virtual mode options [Engtsh (CP-850) ;]
E-mail options This language will be used to specfy national symbols in fie names.
Defragmentation options

[T Confim settings before NTFS <-> FAT/FAT32 conversion,

Choose this option to make the program to allow to customize these settings
each time when convering file systems

OK Cancel

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By
default, the program takes locale (regional) settings from the system. Problems might occur however because of
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different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file
systems.

To tackle problems of that kind you can manually set:

o Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time)
while FAT uses a fixed local date and time. The program takes proper account of these differences and enables
to adjust timestamp values.

A An incorrectly chosen time zone might lead to inability to launch certain software.

e Language for file names to use during the convert operation. NTFS stores file names in Unicode while
FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is
required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

An incorrectly chosen codepage will certainly result in corruption of non-English file
‘ : k names.

e Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically
display the local settings dialog to check and modify (if necessary) the default parameters before launching the
convert file system operation.

Defragmentation Options

%, Edit settings 7 s
General options F . -
Blcki Siaos ol ¥ Defragmentation options
Copy and backup options
Hot processing options Defragmentation mode
CD/DVD recording options I Safe mode fecommended) ~|

Parttioning options
Operation dependency options |~ IoW but reliable. In this mode the program requires free space on the
Vitual mode options defragmented at the moment pastition to guarantee protection of your data in
: ' case of a power outage, hardware malfunction or a system falure
te system conversion options

E-mail options

OK Cancel

In this section you may set the preferable defragmentation mode:

e Fast mode. Partitions will be defragmented rather fast (a 10-30% gain depending on the fragmentation level),
but a power outage, hardware malfunction or a system failure during the operation might lead to the data loss.

o Safe mode. To guarantee protection of your data during the operation, the program will allocate some free
space (not less than the on-disk largest file) on the defragmented at the moment partition to make a duplicate
of every processed file. Thus we strongly recommend you to use this very mode.
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Getting Information on Disks
The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state
of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-
sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information
about the disk in a bright, graphical form.

' Basic Hard Disk 1 {FUJITSU MPF3102AT)

Type: Basic Hard Disk Drive
Total size: 35GB
Sectors per track: €3
Heads: 295
Cylinders: 1245

Create an image of the entire disk
Back up 3l the data this had disk containg, All the paititions on this disk will be added to the archive,

Restore an im of the entire disk
Warning: This opetation wil delete all the data on this haid disk. All the pattitions will be replaced with ones from
the image you have chasen. You may also be asked to restaet your computer during thes operation

Copy the entire hard disk
Create a copy of the entire haed disk
Al the patitions on this disk wil be copiad on the specified Largat disk,

3z
&
&

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may
see a table, which contains the following information:

e Type of hard disk (basic or dynamic),
e Total size (in GB),
e Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed
description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.
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| Logical Disk (G:)

Volume letter: [G:) Serial number; 7493EA8F
Volume label: FAT32-LINLX Partition ID: 0:08 FAT32
Type: Primary Total size: 68GB
File system: FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Activity. Inaclive

Hidden state: Not hidden

A ‘] Create an image of the logical disk
8 Back up all the data this logical disk contains.

7 Restore the logical disk from an imaqe
gg Warning: This operation will delete all the data on this logical disk and replace them from the image you have
T chosen. You may also be asked to restart your computet during this operation.

C? Copy the selected partition
e Create a copy of the paitiion. A new partition wil be created and all the data will be copied there.
- You can create an exact copy. of copy only the area that is occupied by data.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right
will contain the following information:

e Volume label (if available),

e Type of the logical disk,

o File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the
disk settings.

Data Backup and Rescue
In this chapter you will find all the information necessary to establish a reliable data protection system.

Creating Backup Images
We have already mentioned that the most prevalent way to protect valuable data is to create backup copies (backup
images in terms of the program) of it.

Startup
There are several ways to start the Sector Backup Wizard:

Express Launcher

e Click the Backup and Rescue button and then select Backup.
Launcher

e Inthe Main Menu: select Wizards > Back up a Disk or Partition...

e Onthe Common Tasks Bar: click the Back up a Disk or Partition item of the Wizards menu.
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e Inthe Toolbar: click the Back up a Disk or Partition button.

Setup
The wizard offers the following steps to accomplish the backup operation:

e The object to back up. You can back up either an entire disk or separate partitions of the disk (primary,
extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image

such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful
for serious disk recovery procedures.

Name Type R~
= T My Computer My Comprter
= [l [F] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
= [l #= First Hard Disk Track First Track
IE2] = Master Boot Record MER -
@ Local Disk (C) Primary N
[7] Basic Hard Disk 1 (VMware. VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
) First Hard Disk Track First Track
(& Master Boot Record MER

e Backup destination. The wizard allows saving backup archives to local or network drives. You need to select a
destination, taking the estimated archive size and available space on the backup destination into account.

There are several ways the Wizard can store your data. Please select how would you like to save the
archinve:

" Buerni the data te CD ar DVD.

¢ Name and location of the resulted image. Provide a file name for the new image and its exact location. The
program automatically offers an easy to understand name containing the date and the time of the archive
creation, which can anyway be modified.
Select a fokder where archive should be placed and specfy archive name. Archive name wil be used a5 a
subfolder where backup data files will be stored
Mrchive location:  Gi/arc_test/ o K X

ol

— Size | Date
=1 L] My Computer

[l 3 Local Desk (C:)

¥l [5] Archives (G)

+ J images (\WA00.0.1.164'e) (Z:)
1 EX) Metwork

Archive detais
Archive name are_tes)|
Estimated archive size: 2MB

Space available on backup destination: 38 GB

The program automatically calculates size of the future archive and informs the user about
space available on the selected destination.
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e Archive Comment. You can add some additional description to the archive that will later help to distinguish it
from the others.

Plaase snter a shod comment bo describa the archive

f s
Mo comment

Result
After the backup operation is completed you receive an image of the selected disk (or the selected partition). This image
is placed into the specified destination, its features defined by the wizard.

Available operation scenarios:

e Backing up a hard disk or partition to a network drive

e Backing up a dual boot Mac to an external USB drive

Restoring System and Data

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images
created with the program. It provides easy to understand instructions to configure and perform all the necessary
settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the
hint button and then the object you need.

A Restore Wizard is only available for the Linux/DOS bootable recovery environment.

Available operation scenarios:

e Restoring a dual boot Mac from an external USB drive

e Copying of data from the corrupted system disk to another hard disk

e Burning of data from the corrupted system disk to CD/DVD

e Copying of data from a backup to the corrupted system partition

e Restoring separate files and folders from a backup

Copy Tasks

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition.

Cloning Hard Disks

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling
records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be
substituted by simply copying all on-disk partitions.

The program offers the Copy Hard Disk Wizard that can help to clone a hard disk.

Copy Hard Disk Wizard
The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary
settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary
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information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

A You need at least two hard disks to carry out this operation.

Startup
There are several ways to start the Copy Hard Disk Wizard:

Express Launcher
o Click the Copying and Migration button and then select Disk Migration.
Launcher
e |nthe Main Menu: select Wizards > Copy Hard Disk...
e Onthe Common Tasks Bar: click the Copy Hard Disk item of the Wizards menu.
e Inthe Toolbar: click the Copy Hard Disk button.

Setup
The wizard offers the following steps to accomplish the copy hard disk operation:

o The hard disk to copy. Select a hard disk you want to copy.

On this page, you can choose a hard disk you would like to copy. All partitions from this hard disk will be copied
to the destination you will choose on the next page.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

@) Local Disk (C)
939 GEB NTFS
' Basic Hard Disk 1 (vnwae.vn-nmuﬁ;sscsn Disk Dev)
m ©) Local Disk (E) l ©) LoBasic Hard Disk 1 (VMware, VMware Virtual S SCSI D
34 GB FATAZ 24AGBNTFS 4G || W [ENZZGE

o The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to.
Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content wil be deleted

[Basnc Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)l ‘

' Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

e Copy parameters. The wizard enables to specify the following options:
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Choose copy options that sult best your task
Copy options:
{ HOD raw coo{
Parttions raw copy
Perform incremental copy
Change masks for files to exclude from copy
Resize options:
Remove free blocks between padttions
Copy data and resize partitions proportionally

Mark the checkbax to copy the hard disk in the secfordysectormode, thus ignoring ts
7\ nformation structure (e.g. unallocated space or unused sectors of existing parttions will be
G | processad as wel). This can help to avoid problems with hidden data created by certain
= apphcations or the system administrator. However, & will take more time to accomplish the
cperation

Copy options

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g.
unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid
problems with hidden data created by certain applications or the system administrator. However, it will take
more time to accomplish the operation.

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully process
unknown file systems. However it is not recommended to enable this option when working with supported file
systems as it takes more time to accomplish the operation.

Resize options

- Remove free blocks between partitions not to keep blocks of free space between partitions on the targeted
hard disk.

- Copy data and resize partitions proportionally to make the program proportionally change the size of
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger
one.

Verification options

This section allows you to define whether the Surface and/or the Writing verification tests will be accomplished
during the operation.

Result
After the operation is completed, you receive a fully functional duplicate of the existing hard disk.

Available operation scenarios:

e Migrating system to another hard disk (Clone HDD)

Cloning Partitions

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample
partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file
system metadata (location of files, security information, access quotas, etc.).
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The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any
mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description
to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup
There are several ways to start the Copy Partition Wizard:

Express Launcher
e Click the Copying and Migration button and then select Copy Partition.
Launcher
e Inthe Main Menu: select Wizards > Copy Partition...
e On the Common Tasks Bar: click the Copy Partition item of the Wizards menu.
e Inthe Toolbar: click the Copy Partition button.

Setup
The wizard offers the following steps to accomplish the copy partition operation:

e The partition to copy. Select a partition you want to copy.

On this page you can choose a volume to copy

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)
. ©) Local Disk (C:)

453 9GB NTFS
Basic Hard Disk 1 (WMware, VMware Virtual S SCS1 Disk Dey)

@) Local Disk (E2) ] © local Dis... Q) - I I @) (Unallo
¥ 34GBFATR 24GBNTFS ||| 14G. 22GB

At

o Destination disk. Select a hard disk with enough unallocated space to perform the operation.

The wizard will create a copy of Local Disk (F:) from Basic Hard Disk 1 (VMware, VMware Virtual 5
SC51 Disk Dev)

The copy will be created on Basic Hard Disk 3 (VMware, VMware Virual 5 SCS51 Disk Dev)
Plaasa sslect whene to create a copy:

Basic Hard Disk 3 (VMware, VMware Virual 5 SC51 Disk Dev)

I &) (Unallocated)
13.3GB

The program enables to copy a partition to a block of free space, which is smaller than the
partition itself, taking into account only actual amount of data.

e Copy parameters. The wizard enables to specify the following options:
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Your hard disk after changeas

Basic Hard Disk 2 (VMware, VMware Virduad 5 5C51 Disk Dev)

I ) (Unallocated)

Where to place a copy
Plaase specdy the size of the new partiion 3624 39 MB - 20473 MB

Please specify size of free space before the patiion: [ D ME - 20,434 MB
Please specify size of free space afterthe partiion: 16843 & 0 MB - 20,426 MB.

- Partition size. Define the size (in Mb) of the copied partition.

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available
range of disk space.

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map.

Result
After the operation is completed you receive a fully functional duplicate of the existing partition.

Boot Management
Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager
Setup Wizard. Among the key features of the wizard the following should be mentioned:

e Up to 16 operating systems on one PC;

e Secure adding/removing of the Boot Manager startup record to/from the MBR;

e Auto Boot option to automatically start up the previously chosen OS after a certain time period;
e Hiding of any primary partition except selected at the moment.

Startup
Express Launcher

e Click the Boot Management button and then select Boot Manager.
Launcher
e Inthe Main menu: select Tools > Setup Boot Manager...
e On the Common Tasks Bar: click the Boot Manager Wizard item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

o Hiding other primary partitions. By marking this checkbox the program will automatically assign the hidden flag
to all primary partitions of the hard disk(s) except the one selected to boot. This will help to avoid any problems
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when dealing with different operating systems or different versions of one and the same OS, as they will be
unaware of each other.

Boot menu options. In this section you can switch between the following modes:

- Normal mode. Choose this mode to display the boot menu every time the computer starts up and define a
timeout on the expiry of which the program will automatically select the previously chosen item of the menu.

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this mode you
should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will
be displayed.

V| Timaout for booting last used configuration 15| seconds
Hidden mode
Time to display the BoctManager stadup message

Choosa a hot key for startup BootManager.

Deactivating/Configuring the Boot Manager. These two options will only be available once the wizard has been
completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR
(Master Boot Record) or Configure to modify the previously set parameters of the startup process.

o Configure
Choosa this option to antar Settings page. You will be abla to configure BootManager appearancas and Boot

Menu cpbons

Deactivate

Choose this option to deactivate BootManager. This will remove BootManager and restore boot process to s

previous state

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of

the booting process and to be able to display the boot menu.

Available operation scenarios:

Creating Dual Boot Systems

Partition Management
In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations
Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions
The program provides the ability to create a new partition by using the DOS partitioning scheme. This operation can be

accomplished either with the Create Partition Wizard or the Create Partition Dialog.

Besides there's the Express Create Partition Wizard that will analyze your disk subsystem to help you create an NTFS

partition in the most appropriate place of your hard disk by up-taking all the unallocated disk space (if any) and/or an

innocuous slice of the unused space of an adjacent partition, and then make it available in the system by assigning a

drive letter.
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Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports only
hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named Basic Disks).

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be
created:

- Two Extended Partitions on one hard disk
- Five or more Primary partitions on one hard disk
- Ifthere is an Extended Partition on the disk, only three Primary partitions are allowed

4. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free
space on an existing partition to a new partition.

Express Create Partition Wizard Startup
There are several ways to start the Express Create Partition Wizard:

Launcher
e Inthe Main menu: select Wizards > Express Create Partition...
e Onthe Common Tasks bar: click the Express Create item of the Wizards menu.

Create Partition Wizard Startup
There are several ways to start the Create Partition Wizard:

Express Launcher
e Click the Partitioning button and then select Create Partition.
Launcher
e In the Main menu: select Wizards > Create Partition...
e Onthe Common Tasks bar: click the Create Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a block of free space on the Disk Map;
2. Call the Create Partition Dialog to set up the operation. There are several ways to do it:
e Select in the Main Menu: Partition > Create Partition.

e (Call the popup menu for the block of free space (right click of the mouse button) then select the menu item:
Create Partition.
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Express Create Partition Wizard Setup

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only

need to choose a method you find the most suitable to create the partition (if several available), which actually differ in
the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting
this or that mode.

The result you wil get after applying the changes

Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Devy)

I @) Local Disk (C:) I @) dita (Z:) l Q) New V

Please select the method of new partition creation
Smart Mode (Usa 182.1 GBlo craate a parition ) More nfo
@ | Advanced Mode | (Usa 108 5GB!0 create a pattion ) Mere nfo

The number of available methods depends on your disk layout.

A To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

Create Partition Wizard Setup
The wizard offers the following steps to accomplish the operation:

e Partition destination. Select a hard disk (if the computer has several hard disks) and then choose position for
the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between
other partitions.

O this pags you can Salact hard disk and tha placs when (0 creabe & new patiion

Basic Hard Disk 0 (VMware, VMware Virtual 5 5C5] Disk Dev) -

I ) Local Disk (C:) I ) data (£2)

329 GB NTFS 217 GE NTFS
Basic Hard Disk 1 (VMware, VMware Vitual 5 SCS| Disk Dev)

I @) Local Disk (%) L

Basic GPT Hard Disk 2 (WMware, VMware Vilual 5 SCS51 Dizk Dev)

I h. I EJI '-.”” allocated)
The pnr‘lltlcn ill be created "u:rn:] |

Lise the: butbons to mowe the maroer or drag mancer by mouse. A new padition wil be created wheee [ | s,
the markeris. g ¥

By default, the program allows you to create a new partition only as the last primary or as
the last logical drive within the extended partition. However, by activating the advance

A mode on the first page of the wizard you can remove this restriction that in its turn might
result in some boot problems.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



49

e Partition size. There is no restriction on size of the future partition, merely depending on space available on the
hard disk.

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free
space blocks together into one united block and moving partitions when necessary. If the total amount of free
space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus
resizing it.

Yowr hard disk: before the changes

. I I @) (Unallocated)

Yeur hard disk after the changes

Basic GPT Hard Disk 2 (VMware, ViMware Virlual 5 5051 Disk Dev)

I I @) Local Disk (%)

reboot to create the partition and then automatically boots the system again. (The

t If a partition to resize is locked and cannot be processed, the wizard makes the system
rebooting mechanism is different for different versions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate
checkbox.

e Partition properties. On the next page of the wizard you can set a number of additional parameters:
Your hard disk sfler the changes

Basic GPT Hard Disk 2 (VMware, VMware Virual 5 5C51 Disk Dev)
I l W New Volume (E:)

Wolume |abel: | New Volume

Assign the following drive letter- | E Tl

- Partition type. From the pull-down list select a file system the newly created partition will be formatted to,
otherwise the partition will remain unformatted (so that it will not be ready to use).

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.
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Dialog Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes
button to confirm the operation.

(7 )
Are you sure you wanlt lo create a new parlition on disk 37
You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and file sysiem of the new partition.
Basic Hard Disk 3 (WVMware, VMware Virdual 5 5C5]1 Disk Dev)
I 1) New Volume (H:) I
19.9GE NTFS
Create new pastiion 2s: Prmasy patton [
Flease spacify new partibon size 20479 - TMB-20473 MB
Please speciy size of free space befors the parition: 0 * OMB - 20,465 MB
Please specify size of free space afterthe patition: 0 % OMB-20472 ME
Please select file system for new partition: | NTFS El
Flease anter new volume label: HNeaw Voluma
Flaasa spacify dive letter H E|
%) [More options | Yes ] l Mo |

o Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type
from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free
space, both Primary partitions or the Extended Partition can be created.

e Partition Size. Define the size (in Mb) of the new partition.

o Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free
space.

o Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition.

that, just carry out the required operation on the Disk Map. The virtual operations are to be

: Partition size and position may also be defined by using the drag-and-drop technique. To do
available.

o File system for new partition. From the pull-down list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

e Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

o Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.
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In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

7| Uas 05 bask in fomat routine

Flsase select number of sectors per cluster: | 8 [=]
Please select number of sectors per boot

Flease selact number of ool entnes

l‘HﬂStQﬂ:: d-dm.ls_
e Use OS built-in routine. Mark the option to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition.

Available operation scenarios:

e Creating a new partition to detach operating system from the rest of data

Formatting Partitions
Any partition should contain some file system to be used for keeping data. The process of installing a file system is

commonly known as formatting. A huge variety of file systems have been developed these days.

Supported File Systems
The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16
- FAT32

- NTFS

- Ext2

- Ext3

- Ext4
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- Linux Swap v. 2
This operation can be accomplished either with the Format Partition Wizard or the Format Partition Dialog.

Wizard Startup
There are several ways to start the Format Partition Wizard:

Express Launcher
e Click the Partitioning button and then select Format Partition.
Launcher
e Inthe Main menu: select Wizards > Format Partition...
e On the Common Tasks bar: click the Format Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Callthe Format Partition Dialog to set up the operation. There are several ways to do it:
e Select in the Main Menu: Partition > Format Partition.

e (Call the popup menu for the selected partition (right click of the mouse button) then select the menu item:
Format Partition.

Wizard Setup
The wizard offers the following steps to accomplish the operation:

e Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to
format.

Ot 8 voU can chees solume vou WO oo fo
On this page, you Can Cho0se a volume you WOuld iike 10 format

Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Dey)

’l @) Local Disk (C:) ] I @) data Z)
| S — J

2829 GB NTFS 217GBNTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCS| Disk Dey)

l ©) Local Disk (*)
433.5GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virntual S SCSI Disk Dev)

I I (7)) (Unallocated)

A As a result of this operation contents of the selected partition will be lost.
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e Partition properties. On the next page of the wizard you can set the following partition parameters:

Your hand disk: after the changes

Basic Hard Disk 0 (WVMware, Viware Vidual 5 SCS1 Disk Dey)

I @) Local Disk (C:) l @) data (Z:)

olume labal: | Mew Valuma

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only
those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the
next page enables to define:

7] [Use 05 but in fomat routine |

Plaase sslact sectors par Clustar

o -

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

o The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Dialog Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format

button to confirm the operation.
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-2l
= 4’ Are you sure you want to format volume (F:)?

You are about to format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new file system:  [ZNECINNN )
Please enter new volume label: | New Volume

¥) More options l Fomat | | No

e File system. From the pull-down list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected partition, taking its capacity into account.

o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on

the chosen file system, the following options become available:

#| Use OF built in format routine

Please selact rumber of sectors per cluster: | 128 [+]
Pleass sslect number of sectors per boot:

Fleass salect number of oot entries:

Restone Ma-.ts;

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

o The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition formatted to the specified file system.

Deleting Partitions

With the Delete Partition Wizard or the Delete Partition Dialog you can delete a partition on a hard disk partitioned with
the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager included), the program can
not only remove references to the deleted partition from the Partition Table, thus making it unavailable for the
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operating system, but also enables to irreversibly destroy its data. This feature will guarantee security of your personal
information.

Wizard Startup
There are several ways to start the Delete Partition Wizard:

Express Launcher
e Click the Partitioning button and then select Delete Partition.
Launcher
e In the Main menu: select Wizards > Delete Partition...
e Onthe Common Tasks bar: click the Delete Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it:
e Select in the Main Menu: Partition > Delete Partition.

e Call the popup menu for the selected partition (right click of the mouse button) then select the menu item:
Delete Partition.

Wizard Setup
The wizard offers the following steps to accomplish the operation:

e Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to
delete.

On this page. you can choose 3 volume you would ke to delete

Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Dey)

Ilu @) Local Disk (C:) ‘ @) data (Z:)
2029GB NTFS 217GB NTFS

Basic Hard Disk 1 (VMware, VMware Virfual S SCS1 Disk Dev)

l ©) Local Disk (7)
493 9GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Vitual S SCS1 Disk Dev)

I I @) (Unallocated)

‘ ! . You are sbout to destroy a bootable partition!
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A As a result of this operation contents of the selected partition will be lost.

e Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the
required operation from the pull-down list.

Merpe free blocks options

Lo mil marpa Nk IROCxE h | 1-|

Maroe frea blocks & the and 5 thae disk

Dialog Setup
Initially the program suggests you just to remove references to the selected partition from the Partition Table.

7. Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label]. NTFS. Your computer may
no longer boot or work comactly

71 (Do not ask volume lsbel next time |

o Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

o Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.

Result
By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the

modification of the disk layout.

Advanced Partitioning Operations
Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, undelete, etc.).

Merging Partitions

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions,
into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the
second selected partition will be placed in a folder on the resulted joined partition.

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions.

Startup
There are several ways to start the Merge Partitions Wizard:

Express Launcher
e Click the Partitioning button and then select Merge Partitions.

Launcher
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In the Main menu: select Wizards > Merge Partitions...

On the Common Tasks bar: click the Merge Partitions item of the Wizards menu.

The wizard offers the following steps to accomplish the operation:

The partition to expand. Select a partition, the size of which you need to increase by up-taking contents of an
adjacent partition.

On this page. you can ¢ & 3 pattion that will be expanded to include adacent parttion, Please ncte that R is
passbie to select only . FAT32 or NTFS paditions. You will not be able to proceed futher £ no adacent
parttions of these types am present on the disk

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)

I ©) Local Disk (C:) l@ data (Z:)
M 222 9 GB NTFS 217GB NTFS

The partition to merge with. Choose the second partition for the merge operation, the contents of which will be
placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder
name to store files of the second partition, which however can be customized.

Select an adacent pantition 1o merge with the target parttion, This parition wil be marpad to the cne you have

selected on the previous page. The content of the second parttion will be placed in a folder inside the resulting

parton

Basic Hard Disk 0 (VMware, VMware Vituad S SCS1 Disk Dev)

. @) Local Disk (C)) | ©) data (Z)

5B NTFS 217GB NTFS

Specty a folder name to keep content of the selected parttion

Foidar Name |mergaed_partttion_cortent

-

A

Be particularly careful when selecting system partitions to process, since the incorrect
order, in which two partitions have been chosen, will result in inability to boot the
operating system.

Result

After the operation is completed the disk space of the two adjacent partitions will be consolidated.

Redistributing Unused Space between Partitions
This operation can be accomplished either with the Express Resize Partitions Wizard or the Redistribute Free Space

Wizard.

Express Resize Partitions Wizard

The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused
space of an adjacent partition of your hard disk.
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Startup
There are several ways to start the Express Resize Partitions Wizard:

Express Launcher

e Click the Partitioning button and then select Resize Partitions.

Launcher

e |nthe Main menu: select Wizards > Express Resize Partitions...

e On the Common Tasks Bar: click the Express Resize item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e Adjacent partitions to resize. Click on the left partition of the pair of partitions you need to redistribute the
unused space between, as the right one will be selected automatically.

The wizard wil rasize space between Local Disk (C:) 2nd data (Z:) on Basic Hard Disk 0
(VMware, VMware Virtual S SCSI Disk Dev)

Select left panition from a par of agacent pattions you would ke to resize. Right adiacent parttion wil be
selacted aviomaticaly

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

“l ) Local Disk (C?) l @) data ()

282 SGB NTFS TS
LOL IV NIFD LA

F

Resulted size of partitions. Redistribute the unused space between the partitions with the slider or manually by
entering the required value.

Please specfy new sizes of selected parttions

Selected pant of Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Dey)

I @) Local Disk (C:) l @) data (Z:)

Left volume size

28977¢{MB % MB i ME

Result

After the operation is completed the unused space between the specified partitions will be redistributed according to
your needs.

Available operation scenarios:

e Increasing size of a system partition by taking unused space of an adjacent partition

e Resizing partitions of Apple Boot Camp
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Redistribute Free Space Wizard

The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated
space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of
the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate
positions of the partitions and move their contents to new locations.

Startup
There are several ways to start the Redistribute Free Space Wizard:

Launcher
e Inthe Main menu: select Wizards > Redistribute Free Space...

e Onthe Common Tasks bar: click the Redistribute Free Space item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e Partition to enlarge. Select a partition, the size of which will be increased at the expense of other partitions.
Blocks of the free space (if any) will be automatically added to the target partition.
Choosa 3 volume to expand
Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

@) Local Disk (C:) I(_)/daa(z;)
282.9 GB NTFS 217GB NTFS

L) Capasty of the volume (C:)is 282.9 GB. The wizard can expand this volume up to 485.3 GB at the

expance of other volumas

How wil the wizard expand the voluma ?

e Partition to donate. Choose any partition(s) (not only adjacent) to donate free space.

Select volumes to take space from. Free space from that vokume will be used to enfarge the volume you have
selected on the previous page

Volume Fle system | Type |Capacty | Usedspace | Fresspace | ' Free
T

[T FS Prmay  217GB 146GB 2023G

™~

w
>~

L) There is no unalocated space on the hard disk you have selected. The wizard can only expand the
volume (C:) at the expence of some other volumes. Please chck the chack box next to any volume o take
free space from &t

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



60

e Partition size. By default, the program leaves 50% of the unused space on a partition and removes another 50%
to add it to the target partition. However, the size to take can be customized by moving the slider or by
manually entering the exact value.

Your diskc after the changes
Basic Hard Disk 0 (VMware, VMware Vidual 5 5C51 Disk Devw)

I €)) Local Disk (C:) l ) data (£)

Selact new size
353.371,86 ME »| 285.775 MB - £96.975.28 MB

b} Cyment volume sipe; 384,71 GB
Thee volume size has bean increased on 101.1 GB.

Result

After the operation is completed free space of the specified partition will be increased by up-taking the on-disk
unallocated space and the unused space of other partitions.

Undeleting Partitions

When simply deleting a partition (without additional wiping) disk management software only removes references to it in
the Partition Table, thus leaving the possibility to recover it later.

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other
partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program
offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

Startup
There are several ways to start the Undelete Partition Wizard:

e |nthe Main Menu: select Wizards > Undelete Partitions...
e Onthe Common Tasks Bar: click the Undelete Partition item of the Wizards menu.

e Select a block of free space on the Disk Map and click the Recover Lost Partitions item on the page that appears
in the Explorer Bar.

e Call the popup menu for the block of free space (right click of the mouse button) then select the menu item:
Recover Lost Partitions...

Setup
The wizard offers the following steps to accomplish the undelete partition operation:

o Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks.
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Chick: the check box next to any hard disk dive or frese block you want (o eommine

Name Type

= Ell My Computer My Computer
= [¥] [E] Basic Hard Disk 3 (VMware, Viware Vitual S SCSI Disk Dev) Intemal Hard D8

EllSunsocmed [

The summary =z of fragment (3) to analyze is 19.9GB

e Search method. By default, the wizard selects the fastest search method for your operating system. In most
cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance
(the Conventional Search option is selected), but the deleted partition you're looking for has been created with
the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually
select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard
still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in
the specified search area to get the most accurate results.

Choose how to look for the deleted partitions:
Quick search for partiions. created by Vista o later OS |
@ Conventional search
Thorough search
¥ Show file systems search options

To know more on the available search methods, please use the context sensitive hint
system.

o File system filter. By default, the wizard will search for all known file systems. However, by clicking on the
appropriate option on the second page of the wizard, you can specify only those file systems you need.

2 Hide file systems search options
AI known file s)‘stems
FAT and FAT32file systems
V| NTFS file system
Linux Bx¢2 and B3 file systems
0S5/2 HPFS file system
Other funkisted) file system
To begin search, cick Next

e A partition to undelete (if several). By default, the program searches records of any deleted partition ever
existed on the selected block of free space. So you can get several partitions to choose from.
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E; Search deleted partiions from sector: 40 1o sector 275

The following pariitions have been found:

File mystem Type .Capam Used Space [ % Used
T NTFS Primary 199GB 863 MB 0
[ Stop search ]

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the
Stop search button.

Result
After the operation is completed you receive a fully functional partition.

Installing a New Operating System

Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the
system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new
partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and
checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic
tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and
then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all
the necessary operations to install a new operating system.

Startup
There are several ways to start the Install New OS Wizard:

Express Launcher
e C(lick the Boot Management button and then select Install New OS.
Launcher
e In the Main menu: select Wizards > Install New OS...
e On the Common Tasks bar: click the Install New OS item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e Partition to install a new operating system. The program offers two ways of installing a new OS, i.e. to create a
new primary partition for it or use an existing one.
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Wheie would you ke to nstall an operating system?
(®) | want to create a new pimary partition to install 05

A new partiion will be cieated by using unallocated space of your hard disk or unused space of exsting
pastitions. It iz the most preferable way as no system of user’'s data will be affected during the instalabon
plocess

() | want to use an existing pemary partition to instal 0S.

In case creahon of a new primary partiion iz not possible (there are already four primary partitions on the
disk) o not desirable, you are free to select any of existing pamaty partitions. Please note that all data on
the selected partition will be deleted f you choose to format it lates in this wizard Besides make sure no
operating system has already been mstalled on that partibon.

A Only primary partitions can be used to install an operating system.

- In case the first option has been marked, the wizard enables to specify:

A hard disk (if several) where a new partition will be created. Thanks to an advanced program engine it is
possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new

partition;
O thas page wou can choosa a hard disk [ sevveral] whene pou would e to create a new primany partition

E-I]atin Hard Dizk 0 [Maxtor Mr250P0)

ilt_.y['l X ltgl--
| Bl 1533 GENTFS

S

3.7
. Total size: 193,9 GB
+ 7.
Basic Hard Dizk 1 [5T3160815A5) tl;s:?_ 1?]62?%8
.Uu W (0] Igwn
13 634 GH NTFS EE GB NTF5

To avoid any possible problems, the new partition will in no way be created as the first
partition of the disk which already contains at least one partition.

And its size. If there are blocks of the free space on the disk, the wizard will merge them all and allocate the

resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent
partition. However, the size to take can be customized by moving the slider.

You can select ether a block of unallocated space from the disk or an sasting partiion fos whach e unused
apace will be used 1o creste & new paitition

Baszic Hard Digk 0 [Maxtor Ar250P0)

l@m I@m
1821 GB NTFS

51.6GE Nat

New wolume - cument size iz 51.6 GB

Min Volame Size: 0 Bytes : M.z Volame Size: 1565 GB

- In case the second option has been marked, the wizard enables to choose an existing primary partition to
install a new operating system.
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On this page you can choose an exitting primary partition where pou would like to install 3 new operating system
Basic Hard Disk 0 (Maxtor 7Y250P0)
Igj.gm ilwm
163.3 GB NTFS A J 3768

Total size: 163.3 GB
Basic Hard Disk 1 (ST3160815AS)  |Used: 77.2GB

Free: 86,1 GB
y £ 634 GB NTFS

) (E)
66 GB NTFS

A Your computer may fail if any other OS has already been installed on the selected partition.

e Partition properties.

[+] “rez, | want to format the pastition

Partition lype: ENTFS ks
Aszsign the following dive letter: [
Suace testlavel | Mone %

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only file
systems that can be correctly placed to the selected partition, taking its capacity into account.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.

e OS Label. Enter a label for the selected partition in the textual field. It will later be used for the drive
identification.

05 labels vall be dizploved in the Boot Manages’s slaitup merm bo help you boot the requined opesating
syshem,

05 lobet [Windows 7

Result
As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the
computer to launch the installation procedure.

The program will update your MBR, so most likely you won’t be able to start up any of the
A previously installed operating systems. Please launch the Boot Manager Setup Wizard after

the installation has been completed to fix this issue.

Available operation scenarios:

e Creating Dual Boot Systems

Moving/Resizing Partition
The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data.
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In order to move/resize a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Move/Resize Partition dialog to set up the operation. There are several ways to do it:
e Select in the Main menu: Partition > Move/Resize Partition...
e On the Explorer bar: click on the current total size value.

e Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the
Partition List, then select the menu item: Move/Resize Partition...

3. Define parameters of the operation.

>

\ Are you sure you want to move/resize system volume (C:)?
& vo, e about 1o move/resize NTFS volume [No label], (C:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

. @) Local Disk (C:)

2823 GBNTFS

11,823 MB - 289,781 MB

577 850 73

3MB

e Volume size. Define size (in Mb) of the modified partition.

e Free space before. Define the partition position (in Mb) relative to the beginning of the available range of
disk space.

e Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

e Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its
unused space as well. This can help to avoid problems with hidden data created by certain applications or
the system administrator. However, it will take more time to accomplish the operation.

Partition size and position may also be defined by using the drag-and-drop technique. To do

that, just carry out the required operation on the Disk Map. The virtual operations are to be
A available.

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the
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partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting
Windows and interrupting its work, providing 100 percent guarantee that your data is kept
intact.

4. The operation will be performed immediately after confirmation.
Available operation scenarios:

e |Increasing size of a system partition by taking unused space from any other

e Shrinking a system partition to increase size of a data partition

Converting File System

With our program you can change type of the used file system without destroying its data. While performing the
operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the
requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system
metadata and user files.

The program enables to convert the following file system types:
- FAT16 > NTFS, FAT32
- FAT32 > NTFS, FAT16
- NTFS > FAT16, FAT32
- Ext2 > Ext3
In order to convert a file system you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Convert File System of Partition dialog to set up the operation. There are several ways to do it:
e Select in the Main menu: Partition > Convert file system...
e On the Explorer bar: click on the current file system type.

e Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the
Partition List, then select the menu item: Convert File System...

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Convert button to confirm the operation.
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<
"\\\ Are you sure you want to convert system volume (C:)?

1 You are about 1o convert fle system on volume (C:) [No label), NTFS

Your computer may no longer boot or work comectly

e New file system. From the pull-down list choose a file system you would like to convert to. Actually the
program only displays variants available for the operation, taking into account the current parameters of the
selected partition and limitations of the used file system.

e New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the
overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better
performance, because of less fragmentation. So be particularly careful with it.

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it

A into half.

You may only decrease the current cluster size.

e Surface test level. Define the level of the surface check to make the program find bad and unstable sectors
and mark them unusable in the file system metadata.

4. The operation will be performed immediately after confirmation.

Making Logical/Primary
The program allows you to include a primary partition in the extended partition.

In order to change a partition type you should take the following steps:
Launcher
1. Select a primary or logical partition on the Disk Map.
2. Call the Make Partition Logical/Primary dialog to set up the operation. There are several ways to do it:
e Select in the Main menu: Partition > Modify > Make Partition Logical/Primary.

e On the Explorer bar: click on the current partition type.

Are you sure you want to make the partition logical?
- You are about 1o make the paation (C:) [No label). NTFS logca

Yes No
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The Make Primary > Logical option is only available when the selected partition is adjacent

f to the extended partition and vice versa.
The Make Primary > Logical option of the system partition will result in inability to boot the
operating system.

The operation will be performed immediately after confirmation.

Changing Partition Attributes
This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, Volume Label, etc.).

Mark Partition Active/Inactive
The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
Launcher
1. Select a primary partition on the Disk Map.
2. Call the Mark Partition Active/Inactive Dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Mark Partition as Active/Inactive.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Mark Partition as Active/Inactive.

e
6 Are you sure you want to set the volume as active?

You are about 1o set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

—

Yes j No

3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system will
fail to boot.

Hide/Unhide Partition
The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount
hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.

2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it:
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- Select in the Main Menu: Partition > Hide/Unhide Partition.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Hide/Unhide Partition.

3. The operation will be performed immediately after confirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.

Set Label of a Partition
The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Callthe Change Volume Label dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Modify > Change Volume Label.
- Onthe Explorer Bar: click on the current volume label.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Change Volume Label.

3. Enter a label for the selected partition.

Co- s
Are you sure you want to change label on volume (F:)?
- Please specfy a volume label for easier recognition of your volume

Please enter new volume labed: | New Volume

| Yes [ Mo

4. The operation will be performed immediately after confirmation.

Hard Disk Management
In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:

Launcher
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1. Select a hard disk on the Disk Map.
2. Callthe Update MBR dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Hard Disk > Update MBR.

- Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then
select the menu item: Update MBR.

R ===
1 Are you sure you want to update master boot record?
— Cumrent MBR contents for hard disk number 0 will be lost after this operation. Your

computer may no longer boot comectly
‘ Yes i | No

3. The operation will be performed immediately after confirmation.

Extra Functionality
This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general
information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry,
cluster size, exact partition location, etc.

There are several ways to get properties on a partition/hard disk:
Launcher
1. Choose a partition/hard disk on the Disk Map, then select in the Main Menu: Partition/Hard Disk > Properties...;

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, then
select the menu item: Properties...
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a ===

[r——

}Generd, | ﬁo-Sﬂani"lo I Advanced

Local Disk (C:)

Volume: label: [No label)
File system: NTFS
Type: Prmary
Capacity: 4333GB
536,868,814.848 Bytes
1.048.571.904 Sectors
Used by data: 53GB(1%)
10,016,497 664 Bytes
19.563.472 Sactors
Free space: 4306GB (39%)
526.852,317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.

Volume Explorer
Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to

FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon backups as regular
folders to explorer their contents or to retrieve certain files.

Launcher

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer:

Disk View | Help |
Name I Size l Modified I et
«-E8] CD/DVD Drives
=] Hard Disks
= [5] 1. VMware, VMware Vitual S SCSI Disk Devi  40GB
=-@1. Pimary NTFS (C) 39.9GB
-5 SRecycle.Bin 4/15/2010 3:40:55 PM
4/20/2010 7:08:34 PM
4/20/2010 7:42:40 PM =
4/20/2010 7:15:14 PM
4/15/20104:11:30 PM
11/2/2006 5:02:03 AM
4/20/2010 4:18:27 PM
4/19/2010 12:40:49 AM
4/20/2010 9:24:08 PM |
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Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location
(local or network drive, etc.).

5 Select » destination folder for the export aperation [~ B[]

e |

Lock in: (=] Local Disk ) 3 e K ¥

@ Address: | C.f

Disk: Drives. Name Date
48 Locaibekc) |
+ OVD AW Deive (D)
Qﬁ #- [Z] Local Disk [E)
Hetwork Places # [Z] Local Disk )
1 [=] Archives (G)
3 [] Hew Vohame H)

S—T— e

Available operation scenarios:

e Restoring separate files and folders from a backup

Mount Partition
The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:

Launcher
1. Select a partition on the Disk Map.

2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it:

- Select in the Main Menu: Partition > Assign Drive Letter...

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Assign Drive Letter...

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.
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"\\\ Assign a drive letter?

1 This allows access to the volume by using the drve letter assigned. The
assignment is not recommended £ the volume contains a file system not
supported by your operating system

Assign the folowing drve letter: NN ~ |

However you can manually define the required letter by selecting it from the pull-down list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to un-mount a partition you should take the following steps:

Launcher
1. Select a partition on the Disk Map.
2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it:
- Select in the Main Menu: Partition > Remove Drive Letter.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Remove Drive Letter.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

2 system.
After having processed partitions with installed software, some programs may not run
properly.

Test Surface
The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found
any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:
Launcher
1. Select a partition or a block of free space on the Disk Map.
2. Callthe Test Surface dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Test Surface...

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Test Surface...
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3. From the pull-down list choose the level of the surface check.

| | ==
i X

@ Test surface of volume (C:)?

Testing volume surface allows 10 find bad blocks and other problems

Please select 3 suface test level m
| Yes [ No

4. The operation will be performed immediately after confirmation.

Check File System Integrity
The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:
Launcher
1. Select a partition on the Disk Map
2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Check File System Integrity

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Check File System Integrity.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Yes button to confirm the operation.

[ )
v, Check volume (C:) [No label]. NTFS for errors?

1 Please note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

Check disk options:
| Scan for and attempt recovery of bad sectors |

Yes \ No

e Scan for and attempt to recover bad sectors. Mark the checkbox to additionally process sectors marked
bad in the file system metadata for the purpose of their possible recovery.

4. The operation will be performed immediately after confirmation.

View Sectors
With the built-in View Sectors tool you can view sectors on existing partitions/hard disks providing the possibility to
navigate through the system metadata.

In order to view sectors of a hard disk/partition you should take the following steps:
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Launcher
1. Select a hard disk/partition on the Disk Map.
2. Callthe View Sectors dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition/Hard Disk > View Sectors.

- Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map,
then select the menu item: View Sectors.

R ==
Edit sexctors on Basic Hard Diske 0 (Viware, Viwae Virtual 5 5051 Disk Dew)
Cuerent sactor ia Dof 1,048.575,999.

Plese select sector number. |0 D A0 Q- §¢ HE @@

Ox0000000000 33 c0 8= d0 be 00 7c 8= c0 8e di be 00 7c bf 00 3hoPM. LA BN L .]

Ox0000000010 06 b2 00 02 fc £3 ad 50 68 1lc D6 cb fb b9 04 00 b iidHPh. EGY ..
0=x0000000020 bd be 07 80 7e 00 00 7c Ob Of 85 Oe 01 83 c5 10 M. A
0x0000000030 &2 £1 od 18 88 56 00 55 cé 46 11 05 <& 46 10 00 &5 V. VEF. EF,
0x0000000040 b4 41 Bb as 55 cd 13 54 72 Of 81 fb 55 aa 75 09 Thed UL ]y Al
Ox0000000050  £7 <1l 01 00 74 03 fe 46 10 66 &0 30 7e 10 OO0 74 =h. . t.PF.E" .~ .t
0x0000000060 26 &6 &3 00 00 00 00 && £f 76 03 &3 00 00 &3 00 &th fyv.h..h
0x0000000070 7e &8 01 00 68 10 DD b4 42 8a 56 00 8b f4 od 13 |b. . k.. "B.V..4&L.
Ox0000000080 9f 83 c4 10 9= =b 14 b8 01 02 bb 00 7c 83a 56 00 kB ow |V
Ox00000000%90  8a 76 D1 8a 4o 02 8a 6o 03 cd 13 66 61 73 lc fe w. N .n.l fas b
0x0000000040 4e 11 75 Oc B0 7e 00 80 Of 84 8a 00 b2 80 eb 84 Hou .~ 1.5

0x00000000B0 55 32 =4 8a 56 00 od 13 5d eb 9= 81 3= fe 7d 55 U2a V.1 ]2, :b}0
0=00000000C0  aa 75 6= £f 76 00 =8 8d 00 75 17 fa bl dl =6 64 duniv. &, u. 0" Hed
Ox0000000000 o2 83 00 b0 df eb &0 o8 7c 00 bD ff o5 64 28 75 &. . "Be'é|. "yedéu

0x00000000EQ 00 fb BE 00 bb od 1a 66 23 0 75 3b &6 81 fb 54 i, wl f8Au:f 4T
0x00000000F0 43 50 41 75 32 81 £9 02 01 72 2c &6 63 07 bb 0O CPAuz. 4. .xr, fh.».
Ox0000000100 OO0 &6 &8 00 02 0D DD && &8 03 DD 0D OO 66 53 &6 Eh....th. .. ESf
0x0000000100 53 66 55 66 68 00 00 00 00 &6 &8 00 7c 00 00 &6 StUth th.|. . £
Ox0000000120 &1 &8 00 00 07 ed 1a Sa 32 f6 =a 00 7e 00 00 od sh, .1 7254 |..1
0x0000000130 18 ad b7 07 eb 08 ad bé 07 eb D3 ad bBS 07 32 a4 N N RN T
0x0000000240 05 DD 07 8b £0 ac 3c 00 74 09 bb 07 00 b4 Oe cd R ST TR T

0=0000000150 10 eb £2 £4 eb £d 2b c% ed 64 b 00 24 02 =0 £8 eodep+Esde . & se
0x0000000160 24 02 3 49 be 76 61 6o 69 64 20 70 61 72 74 69 $ KInvalid parti
0x0000000170 74 6% 6f 6= 20 74 61 62 6o 65 DD 45 72 72 &f 72 tion table Error
Ox0000000L80 20 &c &F &1 64 69 &e &7 20 &f 70 &5 72 61 74 &9 loading operati
0x0000000190  ée &7 20 73 79 73 74 65 éd 00 4d 69 73 73 &9 de ng system Missin
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Send Log Files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:
Launcher

1. Callthe Send Log Files dialog in the Main Menu: Tools > Send Log Files;
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2. Provide a customer name and a product serial number;

3. Give a detailed description on the encountered problem.

Send log files

2 Send log files,

1 1)
— Please enter short description of your problem and send log files to support

Cusst oemer Mams
John Smith
Serial Number
(1% de-654ac-a4% - Tdaf8-237a2|
Content of inquiry
Heip!

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files
and then send it to the Paragon Support Team.

Log Files
Log files are simple textual files that can be opened by any text editor. There are several log files automatically
generated by the program:

Stubact.log Contains in-depth information on parameters and performance of all operations
carried out by the program

Pwlog.txt Besides brief overview on operations it also contains detailed information about the
state of all hard disks®

Cdb.log Contains low-level information on the CD/DVD devices used in the system

BioNTlog.txt It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain

or valuable information on Windows family operating systems
Bio95log.txt

Log files do not contain any confidential information on the operating system settings or
the user documents.

A The Send Log Files function is only available when outgoing mail server (SMTP) and the user
e-mail address are properly set. To learn more about it please consult the Settings
Overview chapter.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an
operation, what is very convenient.
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In order to view logs on carried out operations call the View Logs dialog in the Main Menu: Tools > View Log Files

=
= B §F BT =

Session event
Staried 9732009 at 12-40:12 AM. Frished at 12.40:29...

Started 9732009 at 12-40045 AM. Frished at 12:41:21_.
Started 3732009 at 12-42:11 AM. Finished at 12:44:25 .
Started 9732009 at 12-45:04 AM. Frished at 12:45:12...
# Stared 3732009 at 12-45:33 AM. Finished at 1:28:31 .
& Started 9722009 at 3:17:40 AM. Finished at 3:21:28 AM N eparations have baan found for the sslacted seasen.
t Stared 3722009 at 3:30:36 AM. Finished at 34104 AM
# Started 9722009 at 5:41:05 AM
# Sared 3722009 at 12-15:43 PM. Frished at 12:20:26...
& Started 9722009 at 12-20-76 PM. Freshed at 12:24:46 .
§- Starded 3722009 at 12:24:456 FM
& Starbed 9722009 at 12-06:15 PM. Freshed at 12:07:47...
# Saded 3722009 at 120747 PM. Fnished at 12:21:18...
& Stared 9722009 at 12-21:18 PM. Frished at 12:30:15...
Sarted 3722000 at 1230015 PM. Finished at 12.31:33..
Started 922009 at 12-31:33 PM. Fnished at 12:41:47...
Sarted 3722000 at 124444 PM. Finished at 12.58:38...
& Started 9722009 at 1.08:03 FM

Cesk: System Configuration Bafore Seasion Disk: System Configuration After Session
Basic Hard Disk 0 (YMware, Viware Viflual 5 SC51 Disk Dev) - Off Basic Hard Disk 0 (VMware, Viware Viflual 5 5C51 Disk Dev) - Off
W ©) W )
NTFS NTFS

Basic Hard Disk 1 (VMware, ViMware Viflual 5 SC51 Disk Dev) - OFf Basic Hard Disk 1 (VMware, VMware Vilual 5 SC51 Disk Dev) - OfF

e l— [ ——
FREE FREE

Basic Hard Disk 2 (Viware, Viware Virual 5 SC51 Disk Dev) - OF Basic Hard Disk 2 (Viware, Vilware Vinual 5 SC51 Diske Dev) - OF

) (Unallocated) .g.m-umd]
FREE FREE

Typical Scenarios
This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can
find here useful recommendations and descriptions of operations.

Backup Scenarios

Backing up a hard disk or partition to a network drive
To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do
the following:

Launcher

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can also be
used here).

2. Onthe Wizard's Welcome page, click the Next button.

3. Onthe What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name
depending on the chosen task.
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Click the check box next to any hard disk drive or partition you want to back up

Name Type -
= G My Computer My Computer
5 |8 [] Basic Hard Disk 0 (VMware, VMware Vitual S SCS! Disk Dev) Intemal Hard Disk Driv
= [ £ First Hard Disk Track Frst Track
] @ Master Boct Record MBR |
BT ¢ :
5 [7] 5] Basic Hard Desk 1 (VMware, VMware Vitual S SCSI Disk Dev)  Intemal Hard Disk Dri
| £ First Hard Disk Track First Track
7 & Master Boct Record MBR
7 &P Local Disk (E) Prmary
] @ Local Disk () Prmary
| {5 Local Disk () Pamary
7] B Local Disk () Primary
= 71 ] Basic Hard Disk 2 (VMware, ViMware Vitual $ SCS! Disk Dev) intemal Hard Disk Driv ~

4 »

The size of objacts to back up: 499.9 GB
Estimated archive size 7.2 GB

4. On the Backup Destination page, select the Save data to local/network drives option.

There are several ways the Wizard can store your data. Please select how would you like to save the
archive:

¥ | Save data to local/netwark drives, |
" Bum the data to CD or DVD.

5. Map a network disk to place your backup image to:

- Call the Map Network Drive dialog by clicking the appropriate button;

Select a folder where archive should be placed and specify archive name. Archive name will be used a5 5
subfolder where backup data files will be stored.

Archive location: |Co/arc_(G0905071551273/ o ¥ .l':
Nand ) Map Network Drive 1B e
Remate location mapping
Anetwork share || ()
45 Map to dive lettes : |2 [
] Make permanent connection
¥) Connect as user OK Cancel

- Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;

- Define a letter from the pull-down list of available drive letters;

- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current
Windows session;

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

6. Edit the archive name if necessary.
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Please specify the archive name. Archive name will be used as a subfolder where backup data files will

be stored
Archive detais
Archive name arc_030909071001085
Estimated archive size 44GB

Space avaisble on backup destnation: 38 GB

Please take into account values of the parameters Estimated archive size and Space
A available on backup destination - if the archive size exceeds the available space, another
network drive needs to be selected.

7. Add comments to your backup describing its contents.

Plaase anter a shod comment bo describa the archive

L
Mo comment

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

A This operation can also be accomplished with the Linux/DOS recovery environment.

Backing up a dual boot Mac to an external USB drive
To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB
drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

2 on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer. It will be automatically started up into the Linux recovery environment (Normal Mode),
since it’s the only mode that provides support for Mac computers.

4. Inthe Linux launch menu select Partition Manager.
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= . ™ ‘ou can create, delete and format hard disk
35 Paragon Parition Manager partitions using Paragon Partition Man ager™,
which will stan now. Upon the star, please
Restore Wizard select the drive and one of its partitions or its

free space. Then actvale the Panition’
_ _ pulkdown menu and select one of the
File Transfer Wizard partitioning operations.

Boot Comector
Metwork Configurator

Log Saver

ol B X6 ot

View the mounted partitions

Stant the command line

0

Eject CD/DVD
Reboot the computer

Paower off

@a™

5. Launch the Backup Wizard by selecting in the Main Menu of the program: Wizards > Backup Wizard.

ard Disk  Partition  Changes [EET:EHN Help

opy Har

! Basic Hard Disk 0 (v - Hard Disk
ion_... .
onCDc Restore W
...

Undelete Pantitions ——
o |E-~15|u: Hard Disk 0 Express Resize Wizard riual IDE Hard Drive,
2| | N Tvonme Jrvee Used e
wariition. | || Basic Hard Disk 0 (S File Transfer Wizard
— Primar  Boot Correciar 29 GB 167G
- 1o Primar 792MB 204C

HNetwork Configurator
| »
- 1

6. On the Wizard's Welcome page, click the Next button.

7. On the What to back up page, select your Mac hard disk.

[retained GPT Disko w| Model VMware Vinual IDE Hard Drive, Size 112 Gb
[N Tvolume [Type [File Sysiem | Size [Used [Volume Tabel [Active |

1 * Primany o 549Gh 142Gb  lecpard Mo
3 = Primary %66 Gh 109 Gh Mo label Yes

8. On the Backup Destination page, select the Save data to any local drive or a network share option.
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Please select how would you like © save the archive

(%) save data to any local drives or a network share

Choose this option if you want o save your data o kcal
mounted or physical partition, 1o USB or FireWare exiernal
drives and 1o a mounted network share. You will be prompred o
choose & kcation you want 1 save the achive 1o,

) Burn data to CD/DVD
Choase this option if you wan! the Wiz ard 1w burn the archive o
CDor BVD. You will be prompied 1o choose a CDor DVD RW
drive.

9. Select an external USB drive as a backup destination.

Specify image file to create

Look in: |I1 (NTFS, 2 on Disk 1) (UFSD disk - 4bp) y] [_ﬁ]
= .. rchive
) SRECYCLE.BIN
I -Trashes
—"r_
i) RECYCLER
I System Volume Inforem ation I Ei
|| head
-
QI renamers | [ mewhiderrn | | Delete (F8) |
: Fibe name: |I!rng_,Dcl phd I I Save |
File type: |'|....;--|.|-- phi vl | Cancel
I < Back l Hexi = | I Cancel I

10. Edit the archive name if necessary.

~ Backup destination

Archive name:
]-Ill'lf". Fan2iBackup Sworageimg_D0.pbi I B

Space available on destination: 34.8Gb

Approximate archive size: 17.5 Gb

Please take into account values of the parameters Estimated archive size and Space
A available on backup destination - if the archive size exceeds the available space, another
drive needs to be selected.

11. Add comments to your backup describing its contents.

~ Archive lxl comment
Please enter backup comments 1o describe the archive

| archive Img_D0 pb, created: 200806.05 13:42:39 |

12. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.
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Recovery Scenarios

Fixing MBR after a boot virus attack
Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack,
thus your system fails to boot.

To fix the MBR of your hard disk, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

f on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

.5 Mormal HMode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

= Floppy disk

= Hard disk B8 MBR

= Find 0Ses on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.
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i Youcan create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

(:

L4

Restore Wizard

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

ol B X6 ot

Stant the command line

0

Eject CD/DVD
Reboot the computer

Paower off

ea™

4. Onthe Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option.

Fleaze choose the operation
() Search for Windows installations i camect
() Correct the Master Boot Record (MBR)
() Correct the partition beot record
() Medify partition parameters

() Correct boot parameters (booini, BCD)

To begin, click Next.

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update
the MBR executable code option.

Please choose the hard disk o correct boot problems:

Basic Disk0 ﬂ

Flease pointowut the operation o perferm:

(T} View the MER
(® update the MBR executable code

() Reorder primary panitions (change sks)

6. Confirm the operation.

j E Update the MBR executable code of the Basic Disk 0 (40,0 Gb)?

I Ye

L~ ]

3
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7. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

Reporting

i You have successfully compheted boot carméction. To view the répan
an the aperations perdormed, click Report

B [ Feror

Paragon Beol Correcior's Repan

Operations perdormed:

Operation #1: Cormect the Master Boot Recond
Hard disk targeted: Basic Disk 0

Status: Successiul
Drate and Time: 2009 Jan 14 Wed 140109

Save Close

8. Click the Finish button to close Boot Corrector.
9. Reboot the computer.

Fixing Windows startup ability
Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything
seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

2 on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.
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-+ Mormal Mode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

& Floppy disk

= Hard disk 8 MBER

& Find 0Se=s on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

» ™ ‘Youcan create, delete and format hard disk
Paragon Partition Manager partitions using Paragon Partition Manager™,
which will start now. Upon the star, please
Restore Wizard select the drive and one of its partitions or its
% free space. Then activate the ‘Panition’

_ _ pull-down menu and select one of the
File Transfer Wizard partitioning operations.

-

Boot Comector

Metwork Configurator

Log Saver

View the mounted partitions
Stan the command line
Eject CD/DVD

Reboot the computer

Paower off

@™ Bai®x6,

4. On the Wizard's Welcome page, select the Search for Windows installations to correct option.

Please choose the aperation

(®) search for Windows installations o correct
O Correct the Master Boot Recard (MER)

() Correct the panition boot recond

() Modify partition parameters

() Correct boot parameters (bootini, BCD)

To begin, click Mext.

5. On the next page choose the required Windows installation from the list of found installations (if several), then
select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties
button to get more info on the selected item.
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Correct Windows installations

Pragram has searched for valid Windows installations an your
computer, The results of the search you can see below, Staus 5 refers
19 a system partition (you can edit the Bootini file), B - a boot panition
(you can correct the System Registry).

N |Partiton |Status [System mat  [Type
1 Disk0, Partition O S4B WINDOWS WinxP

For the highlighted Windows installation, please

paint out the operation o pedorm:

) Carrect drive leters in the System Registry
(=) Edit the Boat.ini file

) Correctthe partition boot record

Adjust 05 o oot on new hardware

Ta continue, click Mext

6. Examine the file — maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate
buttons.

Edit the Boot.ini file on Hard Disk 0, Partition 0

[boot loader]

timeaut=10

defauh=mulitOidiski0irdisk(Dip anition( 1IIWINDOWS.
[operating systems)

multi{00di sk (0)rdisk(0)p anition( IWINDOWS ="Paragon VkiWare Windows XP Partition 01° fasdeiect 1

[ coww | | Insen | | Add | [ pelee |

I Edin ] [ Insert the sample | | Add the sample ]

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to

correct drive letters in the Windows System Registry.
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Correct Windows installations

Program has searched for valid Windows installations on your
compuier. The results of the search you can see below, Status S refers
104 Sysiem panition (you can edit the Bootini file), B - a boot panition
(you can correct the System Regisiry).

|[N |Panmion |Stams [Sysem oot Type
1 Disk0, Partition 0 5+B  WINDOWS Winxp

For the highlighted Windows installation, please

paint out the aperation o perfarm:
(&} Correct drive leners in the Sysiem Regisiry

() Editthe Boovini file

() Correct the pariition boot record

Adjust 05 to boot on new hardware

To continue, click Next,

8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not
sure which installation you need, please use the Properties button to get more info on the selected item.

' Paritions List | Letiers Map

Bebow you can choose a hard disk drive and see all panitions on it Information about drive letiers
assigred 1o these panitions is taken from the System Registry of the Windows installation selected.

[Basic Disk 0 +| 40.0Gb, VMware Virtual IDE Hard Drive
I[N [Type |active  |File Sysem  [volume label [Size |Drive leners |
0 Primary Yes  NTFS WinXP 10 Gh =
1 Primary Mo NTFS Application  9.8Gh E
2 Primary No BackupCapsul [No label] 100 Gb «Manes
3 Primary Mo Free 17.2Ghb <Mone>

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System
Registry.

| Partitisns List |

it. Informaation about drive letiers
the Windows installation seleced.

Lemar
Basic Disk - Dirive

N [Type IO |Drive leners
0 Primary e b =hone>

1 Primary b E:

2 Primary Add I Gh iz o i =

3 Primary — Gb  <Mome=

Recommended o try - C:. If used,
you can release itin Leters Map.

Close

= :

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.
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11. Confirm the operation.

I_L Apply the changes?

(S il

[ va Qo w |

12. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

Reporting

Paragon Boot Correcior's Report
Cperations performed

Operation £1: Change dive leneis

Partition targeted: Hard disk 0, Panition 0
Info: System Root folder is ™~ fpuser, If
Status: Successiul hnd make
Daie and Time: 2009 Jan 14 Wed 16:14:16

B To go to the beginning, click here

13. Click the Finish button to close Boot Corrector.
14. Reboot the computer.

Restoring a dual boot Mac from an external USB drive
Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk
on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

2 on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.
3. Restart the computer.

4. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to work with USB devices.
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-+ Mormal Mode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

& Floppy disk

= Hard disk 8 MBER

& Find 0Se=s on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

5. Inthe Linux launch menu select the Restore Wizard.

Youcan create, delete and format hard disk

Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will start now. Upon the star, please
Restore Wizard select the drive and one of its partitions or its

free space. Then actvale the Panition’
_ _ pull-down menu and select one of the
File Transfer Wizard partitioning operations.

Boot Comector

Metwork Configurator

Log Saver

View the mounted partitions
Stan the command line
Eject CD/DVD

Reboot the computer

@™ Boi®x6 N et

Paower off

6. On the Wizard's Welcome page, click the Next button.

7. On the What to Restore page, click the standard browse button [...] to find the required archive. When done,
double click on it to select.
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Select archive...

File mame: ||l.':-_ vista.pbi |

File type: [asenive fites = pbi v] | cancel |

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information
about the archive.

~ Disk preview
Volume [Type [File System  |Size Jused [volume label |
Basic Disk 0 (Size 112 Gh)

" Primary FATIG 200 Mb 15.0 Mb [Ma label]

- Primary Apple HFS 549Gh 14.2Gb lespard

' Primary HTFS 566 Gh 109 Gb [Ma label]
Anchive details: -
Type: Image of the hard disk
Archive name: 9 0528hddeo_vista/lea_vista pbi
Created: 2008 May 29 Thd 21:16:51 “

To coninmue resiore process, chick Mext,
9. On the next page specify a hard disk to restore the image to.

Basic Disk 0 (VMware Virtual IDE Hand Drive) - 112 Gb

Baskc Disk 1 (2A)- 279 Gb

[!t..-.r Disk 0 ﬂ Model VMware Virtual IDE Hard Drive, Size 112 Gb

N |volume |Type |File System |Size |volume label  |[Active  |Hidden |
Basic Disk 0 (Size 112 Ghb)

|1 B Primary Free 112 Gb Mo Mo

A All contents on disk selected for restoring purposes will be deleted during the operation.
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10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next
button to initiate the restore process.

Vewchames on

Your partitions before operations:

- |

Your partitions after operations:

- Apple HFS leopard NTFS [Ho label)

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress
1: Restore partition or disk (! ]
Operation progress
|
Time elapsed:  00:00:16 Time o finish: 002624

Copied sofar: 1920 Mb  Read so far 192.0 Mb(24.0 Mbys)
To copy: 14.0 Gb  Write o far. L192.0 Mb(38.4 Mb/sh

Crverall progress

Convening disk 0w GPT

Opening archive beo_vista_0000p 000..

Restore Primary partition O (disk 0) from file: /r90528hddleo_vistaleo_vista_0000p 000
Duata writing

Opening archive leo_vista_0001p 000..

Reswre Primary partiion 1 (disk 00 from file: /190528 hddleo_vistaleo_vista_0001p 000
Data writing...

12. After completing the operation close the wizard, and then reboot the computer.

Copying of data from the corrupted system disk to another hard disk
To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot,

please do the following:
1. Connect the second hard disk to the computer.

2. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

f on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

3. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
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incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Normal Mode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

= Floppy disk

= Hard disk B8 MBR

= Find 0Ses on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. |n the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

. You can create, delete and format hard disk
Paragon Partition Manager™ partitions wsing Paragon Partition Manager™,
which will stari now. Upon the siarn, please
select the drive and one of its partitions or its
free space. Then aciivate the ‘Paritlon’
pull-down menu and select one of the

File Transfer Wizard partitioning operations.

Restore Wizard

o

-,

Boot Cormector
Metwork Configurator
Log Saver

View the mounted partitions

B ot

Start the command line

Eject CD/DVD

[
!
\

Ty

Reboot the computer

Pawer off

e

5. On the Wizard's Welcome page, click the Next button.

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.
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Source

CA\ (NTFS, 0on Disk 0) (WinX® v

W My computer
' / (Rootdin
W MyComputer (My computer)
M /mnt (Mounted resources)
M /mnydisk (Local disks)
B W /media (Removable disks)
} IDE CD/DVD (NECVMWa VMware IDE CDR1
B CA (NTFS, 0 or: Disk 0) (WInXP) |
S D)\ (NTFS, 10n 2isk 0) (Applicaton)
e E\ (BackupCapsule, 2 on Disk 0) (UFSD dis

R o

Penamnz (F5) D=la= (F2

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
] /mntdiskmdal/Documents and Settin user v
3 iImndiskmdalDocuments and Settin . A
) Application Data
) Cookies
) Deskwop
@ ) E-Mail Database
@ w2 Favorites
J Local Settings
J My Documents
) PrintHood
< > ) Recent v
Totaldata size: nja [ cax | [  Rename(Fe) | |  Delew (F@ |

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.

Please select how would you like o save the data:

(% Save data to any local drives or a network share

Choose thiz optian if you want 1o save your data wo beal
mounted or physical panition, 1 USE or FireWarne external
drives and to a mounted network share, You will be prompted o
choose a location you want i sawve the archive o,

) Burn data te COYDVD

Choose this aption if you want the Wizard 1 burn the data o
CDor DVD. You will be prompied 1o choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse
button [...].

Select path

| minydisk/hda2 |B

Space avallable on destination: 8.6 Gb
Totaldaa size: nja
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10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress

1. Transfer user data ALllill

Time elapsed:  00:00:03 Time w0 finish 00:00:00

Copied so far 17.0 Mb

Overall progress

Transfering “/mntdisk/hdal/Documents and Settings/User/E-Mail Database” w0 “/mnudisk/hd a2/E-Mail Data
Transfering "/mntdisk/hdal/Documents and Settings/User/My Documents® o “/mntdisk/nda2/My Document
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.
13. Turn off the computer.

Burning of data from the corrupted system disk to CD/DVD
To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the

following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

f on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to burn CD/DVD discs.

-+ Mormal Mode Hain recouvery

& Safe Mode eny ironment
& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MBER

& Find 0Se=s on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
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B » ™ ‘Youcan create, delete and format hard disk
::‘15 Paragon Partition Manager partifions using Paragon Partition Manager™,
- which will stant now. Upon the stan, please
. select the drive and one of its partitions or its
% Restore Wizard free space. Then actvale the Panition’

pulldown menu and select one of the
File Transfer Wizard partitioning operations.

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

OiBRED

Stant the command line

0

Eject CD/DVD
Reboot the computer

Paower off

ea™

4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

CA\ (NTFS, 0on Disk 0) (WinX® v

i My computer
' / (Rootdin
W MyComputer (My computer)
M /mnt (Mounted resources)
M /mnydisk (Local disks)
D W /media (Removable disks)
,} IDE CD/DVD (NECVMWa VMware IDE CDR1
B C)\ (NTFS,0 uy"flx-.b. 0) (WiInxXP I
S D)\ (NTFS, 10n 2isk 0) (Application)
e E\ (BackupCapsule, 2 on Disk 0) (UFSD dis

=R =

FPenam= (F5) D=ju= (F

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
1 /mntdisk/hdal/Documents and Settin [User G
57 /mnidisk/ndalDocuments and Settin . -~
L Application Data
) Cookies
) Desktop
@ ) E-Mail Database
@ i) Favorites
) Local Settings
) My Documents
) PrimtHood
< > ) Recent =
Total data size: nfa [ cax | | Rename(Fe) | [  Deew(ra |
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Click the Calc button to estimate the resulted data size.

7. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item.
Please select how would you like 1o $ave the data

()} Save dala ta any local drives or a network share

Chaose this option if you want o save your data o local
maunted or physical parition, o USB or FireWare external
drives and o a mounted network share. You will be prompied w0
choose a locathon you wanm o save the archive

(%) Burn data to CO/DVD

Choase this optian if you want the Wizard o burn the data o

CD or DVD. You will be prompted to choose a CD or DVD RW
drive.

8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label
by entering it in the appropriate field.

Sebect a recorder w0 burn data

Vendor |Product [Type |
Optiare DVD RWAD-T1704 CD-R; CD-RW, DVD-R
Valume |abel: [my Dand |

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress
1: Transfer userdata | |

Operation progress

(CIITITTITIITIT J

Time elapsed.  00:00:07 Time 10 finish: 00:00:16

Copied so far: 5.0 Mb
To copy: 12.0 Mb

Overall progress

E’lnﬂilu.lullunn[ ]

Creating compilation image

Used burner: DVD RWAD-7170A Vendor: Optiarc
Session opening

Data burning...

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

Copying of data from a backup to the corrupted system partition

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy
these files to make the system be operable again:

1. Start up the computer from our Linux/DOS recovery media.
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Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

f on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

.5 Mormal HMode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

= Floppy disk

= Hard disk 8 MBR

= Find 0Ses on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

. You can create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will start now. Upon the sian, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulldown menu and select one of the

File Transfer Wizard partitioning operations.

Restore Wizard

S @+ £F

Boot Comector

Metwork Configurator

»

Log Saver

View the mounted paritions
Stant the command line
Eject CD/DVD

Reboot the computer

Paower off

QL3R [Ck

4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.
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Source

arc_28050B8134627531 w
=

I3 DIFF128565184 710000000

so arc_280508134%27531 PBF

= arc_280508134627531 pim

6. Double click on the required backup to open.

Source

Ilm.ln-- {arc_rEOSOBI34627531 PEF) I

u H
[ Docume%ls and Settings

I Program Files

I RECYCLER

I Sysem Volume Infermation
I WINDOWS

= cliles.svigz

= AUTOENEC BAT

|2 NTDETECT.COM

E bootini

= nnde =

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source

(] WINDOWS/system (mnidiskhda2/8 [WiNDOWsS ]

) provisioning
) pss
) repair

) security
* || ) srchasst

) system

) sysem32
) twain_32

= okog

= 001947_tmp
r > 3 AryPr .

Total data size: 904 Kb

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.
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Please select how would you like io save the data:

(% Save data to any local drives or a network share

Choose this option if you want 1 save your data w kcal
moumed or physical panition, 1 USB or FireWare external
drives and o a mounted network share, You will be prompted o
choose a lecation you want i sawve the archive o,

) Burn data to CO/DVD
Cheose his optan if you want the Wiz ard 1 burn the data i
CDar DVD. You will be prompled 10 choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard
browse button [...].

Look in: [winpbows ~| 3]

U“l“
0 INtServicePackUninstally

2 AppPatch

) Config B

) Connection Wizard

) Cursars

=) Debug

) Downiloaded Program Files

) Driver Cache

£ EHome v
Prename (F5 [ Newioider (F7) | Deleis (Fil

File name: |imndiskmdalwinDows | | Select |

File type: Jan fites (=4 | Cancel

Help < Back b=t Cancel

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress

1. Trl-nl-‘hl u“rdu II-I'III'I'III-IIII'IIII-IIII'IIII-III SERSENNEENSENNEESR IIIl

Operation progress

Time elapsed:  00:00:04 Time o finish: 00:00-00

Copied so far. 0.9 Mb

Overall progress

II.II!I.IHII-IIII-IHII-IIllilillilillilillililI-I.I L

Transering “AVINDOWS/system” 1o "/mnydiskhdal WINDOWSsystem” - em 1 of 1
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.
13. Turn off the computer.
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Restoring separate files and folders from a backup

The program provides a very convenient option to access backup archives and restore only data you need (the so called
selective restore functionality). This operation can be accomplished either with the File Transfer Wizard or Volume
Explorer.

Volume Explorer
To restore separate files and folders from a backup image with Volume Explorer, please do the following:

Launcher
1. Click the Disk View tab and then choose Volume Explorer;

[.’i:k“ewll-lahl

Name |Size | Modfied B
- B CD/DVD Drives
= I Hard Disks
= [5] 1, ViMware, Yhware Vitual 5 SC5I Disk Devi 40 GB
-85, Primary NTFS () | 39.9GB
-] $Recycle Bin 4/15/2010 3:40:55 PM
#-[E] arc_210410030357578 4/20/2010 7:08:34 PM
- arc_NEW 4/20/2010 7:42:40 PM —
-5 arc_TEST 4/20/2010 7:15:14 PM
=] Boot 4/15/2010 411:30 PM
+-F-] Documents and Settings 11/2/2006 5:02:03 AM
#-E7] Program Files 4/20/2010 4:18:27 PM
¢l ProgramData 4/19/2010 12-40:49 AM
:':!--Zj System Volume Information 4/20.2010 5:24:08 PM :J

2. Browse for the required archive and then open it by double click of the left mouse button.

[.’i:k“ewll-lahl

Name |Size | Modfied | B
- B CD/DVD Drives
= I Hard Disks
= [5] 1. VMware, VMware Vitual S SCSI Disk Devi 40 GB
=@ 1. Primary NTFS (C) 39.9GE
4[] SRecycle Bin 4/15/2010 3:40:55 PM
-] arc_210410030357578 4/20/2010 7:08:34 PM -
= arc_NEW 4/20/2010 7:42:40 PM
i [ arc_NEW.0O1 19GB  4/20/2010 7:32:03 PM
[ arc_NEW.002 19GB  4/20/2010 7:37:04 PM
&[] arc_NEW.003 18GE  4/20/2010 7:42:40 PM
STEETE  15GB 42072010 7:26:52 PM
i | ] arc_NEWpfm 829KB  4/20/2010 7:42:40 PM
-] anc_TEST 4/20/2010 7:15:14 PM hd

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item.
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Disk View | Help |
=4 Name | Size | Modified A
4 -E1 CD/DVD Drives
=] Hard Disks
= [5] 1. VMware, VMware Vitual S SCSI Disk Devi  40GB
=@ 1. Pimary NTFS (C) 339GB
-5 SRecycle.Bin 4/15/2010 3:40:55 PM
4/20/2010 7:08:34 PM
4/20/2010 7:42:40 PM =
4/20/72010 7:15:14 PM
4/15/20104;11:30 PM
11/2/2006 5:02:03 AM
4/20/2010 4:18:27 PM
. 4/19/2010 12:40:49 AM
+]- (] System Volume Information 4/20/2010 9:24:08 PM ~|

4. Select a place on the disk where the file/folder will be extracted to.

Lockin: | [5] Local Disk () ] @ 8 2
@ Address:  |(Cf
_ DiskDrives | |  Date
=
& J. arc_images e )
@ | | o _new LTl |
Netwods Places i |, archdb SrH
& || archive_db YK
i |, Pedlogs F/a kT
& |, Program Fles 927
5 i Users 8%
£ |y Wi B
- |, Windows S22

5. Click the OK button to accomplish the operation.

The current version of the program does not enable to access file archives with Volume
Explorer.

Resize Scenarios

Creating a new partition to detach operating system from the rest of data

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the
only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to
do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos,
favorite films and music, program distributives, whatever. As a result you'll get a very huge backup image. You can easily
tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:
Express Launcher

Click the Partition Manager button and then Partition Manager in the Express Launcher.
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1. Click the Express Create Partition item of the Wizards menu (any of the ways described earlier can also be used
here).

2. Onthe Wizard's Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to
minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to
do is to choose between several modes. The most relevant thing here is the amount of space that will be
allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by
selecting this or that mode.

The resutt you will get after applying the changes

Basic Hard Disk 0 (VMware, VMware Virual S SCSI Disk Dey)

l l Y New Volume (E:)

Flaase salact the method of new pantion craaton
Take all unallocated space at the end of the disk
©) | Smart Mode | ( Use 2433 GBto create a pattion ) More nfo

Advanced Mode (s 141 4GB 1o create a patton ) More nfo

The number of available methods depends on your disk layout.

A To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

4. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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(R Express Create Partition Wizard =]
Creating the partition !
Thea Wizard is now creating the pantition =

?'L?-E*{-" = .-"7:?C. te Partition Wizard @3@

1 System restart is required to complete the operation.
« \ What would you like to do?

The operstion Move partition needs exclusve access 1o the volume C: and
Operstiol cannct be completed without system restat. Alter restart, the operation will continue in
) boot4me mode. Do not tum off the computer until the operation
completes.

> Restart the computer
Flease confim restart of your computer. The operation will be continued after
gystem rastart.

& Retry
Manually close usad filas and ratry tha operation

- The operation cannot be completad wihout rastan bacause some flas are in use and
St prevent axchsive access to the volume

What &

£ X X

5. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

Suboperation progress

[ I
)SG Para Hove partition
[ |

HWork time00:01:53 Time to finish00:02:48
Done: 0.2 MB Read: 98 ME(1.0 MB/s)
AlL: 0 MB Hrite: 0.0 ME(O.0 MB/s)

Overall progress
] |
B R R e AL

Getting partitions info...

Flushing system buffers, please walt..ovsesscssnsnssrasssnasansnssananannnnns
Flushirng suystem buffers, pleass wait.

(Restart enabled)

Modi fying drive *: on hard disk O

Checking parameters ...

Checking files and directories ...

To avoid data loss, please do not reset or turn off the computer.
loperation in progress... press 'ESC' or 'Ctrl-C' to interrupt operation

After completing the operation your computer will be automatically restarted back to Windows where you can see the
newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.

Increasing size of a system partition by taking unused space of an adjacent partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.
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To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

Express Launcher

Click the Partitioning button and then select Resize Partitions.
On the Wizard's Welcome page, click the Next button.

Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well.
This partition will later act as a space donor.

The wizard will resize space between Local Disk {C:) 2nd New Volume (E:)on Basic Hard Disk O
(Whware, VMware Vitual 5 5C51 Disk Dev)

Selact laft partition from 2 pair of adacent paritions you would ke to resize, Right adiacent parttion will ba
selected automatically

Basic Hard Disk 0 f'\l'?dw.lnr_ VMware Virtual S SCS1 Disk |1|w]

nl I @) New Volume (E:)
4603 GB NTF5

A

If you’ve got more than two partitions on your hard disk and a partition you need to
increase is surrounded by other partitions, you’ve got the choice to choose which partition
will act as a space donor. Just click on the left partition of the pair, as the right one will be
selected automatically.

4.

Increase size of the system partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Plazse spacfy new sizes of selactad pattons

Selected part of Basic Hard Disk 0 (VMware, VMware Virtual 5 5C5] ek Dev)

l l ) New Volume (E:)

Left wolume size Right volume size

464 MB B ME —] ameeme 12 me

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

The Wizard has not applied your changes yet. On this pags, you can ethar accept or
A reconsider the changes

Please note that £ you sccept the changes. the Wizard wil physically pefom ol the neccessary
operations and & will not be pessble to undo the changes

Rt may take some time to apply the changes. You may also be asked to rastat your computer duning this
process

Yes. spply the changes physicaly

©) | No. let me reconsider. |
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6. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

/ System restard is required to complete the operation.
/= % What would you like to do?

_2

=

The cperation Redistribule partitions nesds axciusive acoess 1o the valuma C:
and cannat be completed without system restart. After restad., the operation wil
corinug in bocttime made. Do not tum off the computer until the operation
completes.

. Reslar the computer |
Plagss sardim restant of your computer. The aperstion will be continusd sfter |

frRem reRad

& Rty

Manualy closs used filas and retry tha oparation
Cancal

7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

Suboperation progress

Gparacon - -
) [SOFTWARE GROUF] Redistribute partitions
Work timeQ0:01:15 Time to finishO0:00:05
Done: 0,77 Hb Read: 72 Hb(4.0 Mb/s)
All: 0 Mb HWrite: 0.0 Hb(0.0 Mb/s)

Overall progress

[T TS SOOI O T F

Quick data mowling ...
Flushing system buffers, please wait.

Modi fying drive =: on hard disk O

Checking parameters ...

Scanning dir structure ...

Scanning data stroctiure (Rag be a fed minutes) ...
step 1 ...

step 2 ...

Jo not reset or turn off your computer - to avoid the data loss.
Jperation in progress... press 'ESC' or 'Ctrl-C' to interrupt operation

After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Increasing size of a system partition by taking unused space from any other

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But one of your
partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:
Express Launcher
Click the Partition Manager button and then Partition Manager.

1. Inthe main window select the required hard disk (if several) on the Disk Map.
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[E] Basic GPT Hard Disk 2 (Viware, VMware Vitual S SCSI Disk Dev)
B Local Disk ) o
€ (Unalocated) 473BFFBDA

< |

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
'-I. l A‘" 1
| 10...
1u"

2. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch

Data (F:) | I TEMP (G:)
200GB NTFS 160.3GB FAT3Z |

the Move/Resize dialog.

A I A Sl P = NE L

Disk View | Help |
SNeme S
— =] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev)
u
Format Partition...
% Delete Partition...
- Move/Resize Partition. .
Convert File System...

a Defragment Partition...
’ Defragment MFT...

’ Compact MFT...
Change Volume Label... |
Hide Partition B Loc
Mark Partition as Inactive ﬂ
ad
Make Partition Logical

Change Cluster Size...
Change Serial Number...
Change Partition ID...

Downgrade NTFS version... Sex
Change SID...

Test Surface...

Y5 CheckFile System Integrity KEl=

41. NTFs W Edit/View Sectors... o

Move or resize the sele.

Properties...

r

3. Inthe opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing
this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by
entering the exact size of free space. Click the Yes button to continue.
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Are you sure you want to move/resize volume (G:)?
You are about 1o move /resze FAT32 volume TEMP, (G:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
©) (Unallocated) ’”’ ) TEMP (G))

535GH 100.7 GB FAT32

Volume size: 103.16733 M8 #[+] 86 MB- 164.156 MB
Free space before: £0.52335MB &[] Obytes- 16407009 M8
Free space after: [ Bytes *[=] Obytes - 164.070.09 MB

Seledthsop(mlomovepmmmlhadon\codmwdaa This allows you to keep
the parition’s content after move exactly as @ was, but will require more time

4. Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by
carrying out a number of extra move/resize operations.

Bﬂclludﬂd(O(Vll'n VMware Virtual S SCSI Disk Dev)

\ Data (F:) . l TEM...
; 200GBNTFS 100.7.

5. Since the block of free space is within the extended partition, you need to take it out first. The program enables
to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s
between two logical disks. So we need to move it. To do that, please select the first logical partition and then
call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
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I A || TIVTR S 'Sl
Disk View | Help |
= Name R | saee
— =] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev)
3| B 5 20
Format Partition...
% Delete Partition...
.
Move/Resize Partition, .
Convert File System...
‘ Defragment Partition...
’ Defragment MFT...
’ Compact MFT...
Change Volume Label... I
| Parttion List Hide Partition g Loc
Llh,,,"e,,,,,, I— Mark Partition as Inactive
Basic Hard Disk 0 (VI £ : v
| Make Partition Logical
| (Disk Map Change Cluster Size... il
Buc Had [h* 0 ) Change Serial Number...
Change Partition ID...
| Local Disk C =
‘ M 35968 NTRS Downgrade NTFS version... Sex
Change SID...
Test Surface...
Y5 Check File System Integrity KEl=
- -
< |. e n Edit/View Sectors... e
: Properties...
Move or resize the sele -

6. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the
partition size has been left unchanged.

Are you sure you want to move/resize volume (F:)?
You are about to mova/rasize NTFS volums Data, (F:).

Basic Hard Disk 0 (VMware, VMware Vidual S SCSI Disk Dey)

‘lg(malocaed) ']Igoua(&)
M sce 140.4 GB NTFS

Volume size: $38M.14 M8 &[] 94MB-26575¢ MB
Free space before: (121.52300MB  2[] Obytes - 265.700.04 MB
Free space after 0 Bytes *[] Obytes - 265.700.04 MB

[} Sactorto sactor move
Selact this option to move pattion areas that dont contan any data. This allows you to keep
the parttion’s content after move exactly as & was, but wil require more time.

7. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it
(right click of the mouse button) to launch the Move/Resize dialog.

8. Inthe opened dialog shift the edge of the extended partition to the right.
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% Are you sure you want to move/resize extended partition on disk 07

| Basic Hard Disk 0 (VMware, VMware Vitual 5 SCSI Disk Dev)

) i etocater) @) Data (F) @) TEMP (G)
LEigi 1404 GB NTFS 100.7 GB FAT32
Volume sze 2¢703860M8 _+ =] 247.038 MB - 362,969 MB

Frem space befors: | 121.530.34 MB ;lzl Olbytes - 12193054 MB
Fres space after 0 Bytes e E

actor o aector mave

Sedect this aption to mowe pardition amsas that don't contan any data. This allows you to keep
the partition’s content aftsr move sxactly a3 & was, but wil reguins mons tims.

9. The block of free space has been released.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
Ap... (Unall...
100. 115GB

10. Now you need to move the second primary partition just the way we did it with the logical partition to make the
block of free space adjoin the system partition.

Data (F:) I TEM...
1404GBNT... || B 1007..

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

(Unall... ... Data (F:) TEM...
11968 100.. 1404GBNT... || ™ 1007, |

11. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to
launch the Move/Resize dialog.

12. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

’6 Are you sure you want to move/resize system volume (C:)?
T You are about 1o move/resize NTFS voluma [No label]. (C:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)
158.7GB NTFS

Volume size 162.547.31 MB #[] 11.680 MB - 162,543 MB

Free space before: 0.37 ME ¢[=] Obytes - 150,868 20 MB

Fres space sfter. 0 Bytes *+[=] Obytes - 150.260.33 MB
| Sectorto sector move

Select this option 10 move pattion areas that dont contan any data, This allows you to
keep the pandtion’s content after move exactly 3s & was, but will require more time

13. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.
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@ 7 =
Apply pending changes ?

[~ Do not show this message again fas Mo

14. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

Shrinking a system partition to increase size of a data partition

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is
exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system
partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily
tackle this problem with Paragon Linux/DOS Recovery CD.

To increase size of a data partition by taking unused space from a system partition, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

2 on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Hormal Hode Hain recouvery

& Safe Mode environment
& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MER

& Find 0Se=s on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Partition Manager. You can find it in PTS DOS as well.
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- Youcan create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

(:

L4

Restore Wizard

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

ol B X6 ot

Stant the command line

0

Eject CD/DVD

Reboot the computer

@ Paower off

4. Inthe main window select the required hard disk (if several) on the Disk Map.

%

Hard Disk  Partition Operations  Wizards  Help

_ Basic Disk 0 (Vidware Viegal - 120 Gb
nage af ha D: NTFS Data
ge of hard

| Disk from
isk.. [Basic Disk 0 | Model viware virual, Size 120 Gb
| |volume |Type |File System |Size |Used |Free
Basic Disk 0 (Size 120 Gb)
0 C Primary NTFS 444Gbh  81Gb  36.26Gb
1 Primary NTFS 7556 Gb 4.9 Mb 756 Gb

5. Choose your system partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.

Basic Disk 0 (VMware Vinual) - 120 Gb

gg Create an image of partition... Al-B I

Burn an image of partition o CO/DVD...

N olume [Type Restore partition from image. .. AltR E
Basic Disk 0 (Size 1 Copy panitien AC
o C Prima 6.2
1 e PrIma o aie T
Farmal... Al-F
Dalete. . AlD
Wipe paniion, ., Al

Clear free space

Unmount... '!

Madify ¥
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6. Inthe opened dialog set a new size for the partition by moving the slider or by entering the exact value in the
appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click

OK to continue.

Partition preview

C: HTFS Vista 64

New size: (8323 - 45434) Mb

Free space before: (0 - 37111) Mb

=
-

Mb

Mb

Free space afier: (0-37111) Mb
412 | Mb

Ll

H 1) E

7. Now you’ve got a block of free space to add to your data partition.

Baskc Disk 0 (VMware Virtual) - 120 Gb
_ _

8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the

Move/Resize dialog.

9. Move the slider to the right to increase size of the partition. Click OK to continue.

- Paniion préview

New size: (8- 102101) Mb

:.1& 102101 | Mb
Free space before: (0 - 102093) Mb
: c—r
Free space afier: (0 - 102083) Mb
] I L

10. Apply the pending changes.

Applying changes

& 2 pending operations
Apply changes 7
= Il
Undo all ||
[ Apply [ ” You have pending op

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
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Operations list Suboperation progress
1: Mave partitsaon I
2: Move partitson Operation progress
(ed
Time elapsed:  00:00:58 Time o finish: 0L:35:42

Copied so far:  248.5 Mb Read so far: 365.9 Mb (7.8 Mbys)

To copy: 7.9Gb  Write so far: 251.2 Mb (46.0 Mbys)
Owerall progress

i
Data maving -
Creating new partitson _.
Moving drive idev/sdad on hard disk 0
Scanning data structure (may be a few minutes)
{Restart enabled)
Data blocks calculating
Quick data moving ... ~

Resizing partitions of Apple Boot Camp

Let’s assume you're a Boot Camp user who's got Windows XP as the second operating system. Initially allocated space
for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some
space from your Mac partition, thus redistributing the unused space between the partitions.

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:
Express Launcher

1. Click the Partitioning button and then select Resize Partitions.

2. Onthe Wizard's Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system)
partitions of your Boot Camp configuration.

The vazaed vall iesize space betwesn Local Disk [°] and WinkP [C:) on Hetained Bazic GPT Hard
Digk 0 WMware Virtual IDE Hard Drive)

Select left partition from & pair of adjacent partkions pou would ke to resize. Right adiacent pastition wall be:
zelected automatically.

Retaned Bagic GPT Hard Disk 0 VM ware Virtual IDE Hard Drive]

I Itumlﬂiulr.l'] l I"-u'inb{Pll'_‘;]
54.8 GE Apple HFS EEEGENTFS

megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just

: On the disk map you can also see the GPT service partition (called EFl) as well as a 128-
for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.
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Please specify new sizes of selected pattiions.

Selected part of Hetaned Basic GPT Hard Disk 0 [VMware Yitual IDE Hard Drive)

I @) Local Disk () I ) WinXP (C:)
40,2 GB Apple HFS 71.1 GB NTFS

Left volume size: Right volume size:

41250MB T MB & 72835MB < MB

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

. The Wizasd has not apphed pous changes yet. On this page, wou can edher accept o
!E reconzider the changes.

Pleass note that if you accept the changes, the Wizard vill physically pedom al the neccessary
operations and # will not be possible to undo the changes.

It msay take some time to apply the changes. You may also be asked o restat pour computer dunng this
2=

‘whoudd pou Bke bo apply wour changes 7

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

A\ Spstem restait is required to complete the operation.
/= ' What would you like to do?

The opesation Redizstribute partitions nesds ewcheive sccass to the volume C:
and cannot be completed wathout system restart. After restart, the operation vl
confinue in boot-time mode. Do not turn off the computer until the operation
completes.

|E Restart the computer '
Plaase confirm regtart of pour computer, The operation will be contnued alter
sysbam restan,

£ Retey
Marually close used fles and ety the operabon

7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.
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Suboperation progress

6Pal'iElf.':'ml:II'l . "
) [SOFTWARE GROUP] Redistribute partitions
Work timed0:0l:15 Ting to finishO00:00:05
Done: .77 Hb Read: 72 Hb(4.0 Mb/s)
All: 0 Mb HWrite: 0,0 HB(0.0 Mb/s)

Overall progress

Quick data moving ...
Flisshing suysten buffers, pleass walt.

Hodi fuyimg delve ®: on hard disk O

Checking parameters ...

Scannlng dir structure ...

Scanning data structure (may be a fed ninutes) ...
step 1 ...

step 2 ...

Jo not reset or turn off your computer - to avoid the data loss.

Jperation in progress... press "ESC’ or 'Ctrl-C’ to interrupt operation
After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Creating Dual Boot Systems

For Windows computers

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection
we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista +
Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system
independence these operating systems will be installed on different partitions. That is why we need to hide the first
system partition before installation of the second OS.

Windows Vista + Windows XP

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing —
your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near
future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-
proved Windows XP.

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the
second operating system you need to repartition your drive first, as it requires a separate primary partition. If this is the
case, you can do your job either with the Install New OS Wizard (a specially designed tool for that) or traditionally with a
number of the corresponding wizards and dialogs.

Install New OS Wizard

This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

Express Launcher
1. Click Boot Management and then select Install New OS in the Express Launcher.
2. Onthe Wizard's Welcome page, click the Next button.
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3. Select the appropriate option to create a new primary partition on your hard disk.

YWhere would you ke to instal an operating system?
© |want 1o create a new pamary parition 1o install 05
Anew parttion will be created by using unallocated space of your hard disk or unused space of existing
pattions. It is tha most prefarable way as no system or usar's data will be affactad dunng the installation
process
| want to use an existing pAmary parttion to instal OS
In case creation of 3 new pamary partition is not possbie ¢here are aiready four pamary parttions on the
disk) or not desirable, you are fres to salact any of exsting pamary panttions. Please note that all data on
the selected partition will be deleted f you choose to format & later in this wizard. Besides make sure no
operating system has already been installed on that parttion

4. On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free
space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If
not, it will take 50% of the unused space of an adjacent partition, thus resizing it.

You can salect ather a block of unalocated space of the disk or an existing pastition, unusad space of which wil
be sarved 10 create a new pantion

Basic Hard Drsk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Vista (C)) I ©) (Unallocated)
158.7 GB NTFS

3412GB

Volume Size: 0 Bytes || MaxVolume Size: 241.2GB

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to
install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

|| Vas, | want to formal the partition

Parttion type: | EINTFS 3
Assign the follywing drive latter: | E E]

Sufacetestlevel: | None [

On this page you can specify a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

6. Enter alabel for the future partition in the textual field. It will later be used for the drive identification.

(05 labels will be displayed in the Boot Manager's startup menu to help you boaot the required operating
system.

05 label: |Windows ¥F|

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate
the installation process.

8. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find
all the necessary information in documentation that comes with the product. However to avoid any problems,
we consider it necessary to draw your attention on the following issues:
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- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first

or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.

Windows XP Profezzional Setup

The following list szshows r gxisting partitions and
unpartitioned 5] on t : puter.

Use the UP and DOWN ARROW keys to =e an item in the list.
To set up Windows KF on the selected item, press ENTER.
= To create a paptition in the unpartitioned szpace. press

- To delete the selected partition. press D.

238591 HE Disk B at Id B on buz B on atapi [MBRI]

*aptitionl {Inactive

9. Soif everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows
Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do

that, please install our program once again, but this time in Windows XP to activate Boot Manager.

10. Click Boot Management and then select Boot Manager in the Express Launcher.

11. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary
partitions except the one selected to boot and it is by all means should be activated to make Windows Vista and
Windows XP unaware of each other. The rest of the parameters offered by default will do in our case, so just

complete the wizard and it will automatically find the two operating systems and update the MBR.

Boot menu cptions
o Normal mode
V| Timecwut for booting last usad configuration 15 saconds
Hidden mode
Time to display the BootManager statup message

Choosa a hot key for stanup BootManager

12. Now restart the computer to make sure you have got a dual boot system.

Traditional way

This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

Express Launcher
Click the Partition Manager button and then Partition Manager.

1. Inthe main window select your hard disk on the Disk Map to make a block of free space on it.
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~ Local Disk (E:)

Volume letter: (£ Serial number:
Volume label: [l abel Partition 1D:
Type: Prmay NTFS version:

File system: !NTF Volume Size:

Root entries: 32 Partition size:
Sectors per boot: £ Used space:
Sectors per cluster: 2 Free space:
Activity:

Hidden state:

Move/Resize Partition
3 g Resze or Move patition.

Format Pastition
ég This wizard haips you to fomat the selected parttion.
| Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev) g
Local Disk (E:)
4995 GB NTFS

2. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call
the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog.

ek

@ s

'/,8\ Are you sure you want to move/resize system volume (C:)?

~ You are about to move/resize NTFS volume [No label]. (C:).

I @) Local Disk (C:)
N 39.9GB NTFS

|.BachadDilk0(VMm.VMmVinudSSCSIDischv)

Vomesize:  [40.958MB 3] v| 18.261 MB-40.958 MB
Free space before: [0.97 MB 2] ~] Obytes-2269335MB
Free space after: IO Bytes 3: EI Obytes - 22,689.77 MB

[T Sectorto sector move

Select this option to move parition areas that dont contain any data. This allows you to
keep the parition’s content after move exactly as it was. but will require more time.

Yes No ]

3. Inthe opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this,
free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering
the exact size of free space. Click the Yes button to continue.
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'/,G} Are you sure you want to move/resize volume (E:)?
X You are about to move resize NTFS volume [No label), (E:)

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

l @) Local Disk (E:) ,_",,. ©) (Unallocated)
268 3GB NTFS 2316GB

27

Volume size 276.730.514mB #[=] 101 MB-511.993 MB
Free space before: 0.97 MB 2[»] Obytes -511.851.43 M8
Free space after: | 237.201.52MB  12[+] Obytes -511.883.61 MB

Sactor to sector move

Selact this cption to move pantion areas that dont contain any data. This alows you to keep
the pattion’s content after move exactly as t was, bt will require more time

The Move/Resize dialog offers a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

4. Now you have a block of free space sufficient in size to hold a new partition.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev) !

Vista (C:) (Unallocated)
158.7GB NTFS 3412GB

5. Create a new partition to install Windows XP. To do that, please call the context menu for a newly created block
of free space (right click of the mouse button) and launch the Create Partition dialog.

@
Are you sure you want to create a new partition on disk 07

You are about to creste a new partition in (Unallocated). 18.3 GB area. Please select size,
paosition and file system of the new partition.

 Basic Hard Disk 0 (VMware, VMware Virtual 5 5CS1 Disk Dev)

I %)) New Volume (E:)
18.3 GB NTFS

Create new parition as: Primary parttion -

Please specify new partition size: 188345 TMB-18.834 ME
Pleasze specly sze of free space before the pattion: |0 =1 O ME - 18.826 MB
Please specify size of free space afterthe parttion: [0 =] 0 MB- 18,826 MB

Please select file system for new parttion: | NTFS |

Please enter new volume label: INEW Voluma

Please specify drive lefter: | E: *

¥ More options Yes I | Mo

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



120

6. Define parameters of the future partition. By all means it has to be primary and since we are going to install
Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

Create new pattion as [Primary poston B9
Pleasa spechy new parttion size 249451 > 7MB-345451 MB
Please specfy size of free space before the paditicn: |0 & OMB-343437MB
Please specfy size of free space after the pattion 0 s OMB-343443M8B
Pleasa salact file system for new pattion: NTFS [w]

Pleasa antar naw volume labal

0y

Please spacfy dnve letter F |w!

¥) More options l Yes } [ No J

The Create Partition dialog offers a number of additional parameters that can also be of
help. However here we pay attention to the most relevant to fulfill our task.

7. Asaresult of the operation we have got a newly created FAT32 partition just enough in size to comfortably
work with Windows XP.

'Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I Vista (C:) New Volume (F:)
158.7 GB NTFS 341.2GB NTFS

8. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it is the
best way to provide system independence. To do that, please call the context menu for it (right click of the
mouse button) and launch the Hide Partition dialog. Click the Yes button to continue.

E

@ 7=
; Are you sure you wanl to hide the partition?

* You are about to hide partition (E:) New Volume, NTFS. Hiding the parition may
cause drive letters to be changed.

Yes No

A Hiding of the system partition will make OS non-bootable, what is quite normal.

9. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

e

@ 7=
Apply pending changes ?

[ Do not show this messace A58in Yes I Mo
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10. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

After all the operations are completed you will not be able to restart the system, what is
quite normal. Nevertheless if you do try it, the following error will occur:

JAN

cess terminated unexpectedly with a sta

11. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find
all the necessary information in documentation that comes with the product. However to avoid any problems,
we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first
or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.
Windows HP Professzional Setup
The fo 1w ing izt = 2 I cing partitions and
unparti sl o 3's
Use the UFP and fH ARROW Kk E ot am item in the
To zet up Windows XP on the zelected item, press ENTER.
= To create a paprtition in the unpavtitioned space. press

= To delete the zelected partition. pwr

238591 HE Diszk B at Id B on buz B on atapi I[MBRI]

Partitionl {Inactive ¢ Boot HanlB B HE «
Faptition R E 7 M H |

A Installation of Windows XP will make Windows Vista non-bootable.

12. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to install
our program once again, but this time in Windows XP to activate Boot Manager.

13. Click Boot Management and then select Boot Manager in the Express Launcher.

14. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary
partitions except the one selected to boot and it is by all means should be activated to make Windows Vista and
Windows XP unaware of each other. The rest of the parameters offered by default will do in our case, so just
complete the wizard and it will automatically find the two operating systems and update the MBR.
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Boot menu cptions

o Normal mode
V] Timeout for booting last usad configuration 15 saconds
Hidden mode
Time to display the BootManager statup message

Choose 3 hot key for stadup BootManager

15. Now restart the computer to make sure you have got a dual boot system.

Windows XP + Windows Vista

If you've got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications will
flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows Vista for
studying purposes.

As this very situation is very close to the previous one, please use the Windows Vista + Windows XP scenario. However

please take into consideration one more step you need to accomplish if you decide to use the traditional scenario:

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive as well.
To do that, please call the context menu for it (right click of the mouse button) and launch the corresponding
dialog. Click the Yes button to continue;

e

) T[S
; Are you sure you want to set the volume as inactive?

You are sbout to set the volume (C:) [No label], NTFS as inactive. You computer
may ro longer boot comactly_

C T ho

Reviving the system partition

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached the point
when all changes are applied and everything is ready to install the second OS, please do the following to make your
system bootable once again (only relevant for the traditional scenario):

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS recovery environment either

f on a CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe Linux launch menu select Partition Manager.
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» ‘Youcan create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

ft

L4

Restore Wizard

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

ol B X6 ot

Stant the command line

0

Eject CD/DVD

Reboot the computer

@ Paower off

3. Inthe main window select your non-bootable Windows partition on the Disk Map.

&] ¥}

[ Bask Disk 0 (Viware Virtual IDE Hard Drive) - 250 Gb

C: NTFS Vista
k

-~

[s-. aske Digk 0 ] = Model VMware Vinual IDE Hard Drive, Size 290 Gb
N [voleme |Type |Fise System |Size |used |Free |vielume Label
Basic Disk 0 (Size 250 Gbi
L Primary NTFS 200 Gb 1.7 Gb 199 Gb Vista
1 Primary FAT32 49.7Gb 4.9 Mb 496 Gb Mo label]

4. Unhide the partition by calling the context menu for it (right click of the mouse button) and then selecting
Unhide.
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ud Disk 0 (Size 40.0 GB)
| Back Up Pariition... Al-B ::;;:E ;:: g:
Burn Partifion on CDor OVD., ) ’
Restare Partition... Al-R
Copy Partition... Al-C
Format Partition.., Al-F
Delete Parition... Ali-D
Move/Resize Partition... Al-Z
Convert File System...
Unmount...
| Setinactive
| Change Cluster Size...
Test Surface.. Change Volume Label. .

Change Serial Number...
Change Partition ID...
Change S51D...

Check File System Integrity

EditView Sectors

- Make ical
Browse Partition.., ake logica

Properies

Defragmentation ..,

Mavigate through "TAB' and |

T

Merge with...

5. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well by
calling the context menu for it (right click of the mouse button) and then selecting Set Active.

e p 1 s A ran o

Farmal Partition.._. Al-F
Delete Farition... Alt-D
Move/Resize Parition... Alt-Z

Conven File System...

Unhide
Unmount.. m
Change Cluster Size...

Change Valume Label...
Change Serial Number...
Change Partition 1D. ..
Change 51D...

Test Sudace._ ..
Check File System Integrity

EdiyView Sectors

Make logical

D rmssorm Fimatitine

6. You will be notified after the operations are completed.
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Operations list: Suboperation progress

1: Se1 panition flags
Operation progress

Time elapsed: 00:00:26  Time 1o finish

Cwverall progress

Rebuilding paritions info..
All operations have been finished

7. Restart the computer.

System Migration Scenarios

Migrating system to another hard disk (Clone HDD)
Let’s assume that you’ve bought a new hard disk. It’s faster and of much higher capacity than your current system disk,
so it’s quite natural you start thinking about system migration. We can help you do that.

To migrate your system from one hard disk to another, please do the following:
Launcher
1. Connect both source and destination disks to the computer.
2. Turn on the computer.
3. Click the Copy Disk item of the Wizards menu (any of the ways described earlier can also be used here).
4. On the Wizard's Welcome page, click the Next button.

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy).

On this page. you can choose a hard disk you would like to copy. All partitions from this hard disk will be copled
to the destination you will choose on the next page

Basic Hard Disk 0 (VMware. VMware Virtual S SCSI Disk Dev)

@) Local Disk (C:)
M 439 5GBNTFS

)

| Basic Hard Disk 1 . VMware Virtual S SCS! Disk Dev) i

‘ I @) Local Disk (E"‘Bastc Hard Disk 1 (VMware, VMware Virtual S SCSI Disk DZV)FI"' '
! 34 GB FAT3Z TEZZAGENTFS % || W WNZ7GE i

m

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk).
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Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content will be deleted.

'Mmmum.mmusmlutmﬂ

|I @) Local Disk (C))

| 453 3.GB NTFS

Basic Hard Disk 2 (VMware, VMware Virtual 5 SCS| Disk Dev)

|. [_}J Archives (G:) @Bada.pl:mﬂe
41.9GE NTFS || 33GB

L] {Unalloq Basic Hard Disk 3 (VMware, Vihware Virtual 5 SCSI Disk Dw}]
4933 GE

A During the operation all contents of the destination disk will be deleted.

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data with a proportional
resize to occupy the entire disk. Besides we recommend you to enable the surface test to make sure your new

hard disk is flawless.

Choose copy options that sut best your task:
Copy options:
[~] HDD raw copy
Parttions raw copy
[] Perdom incremental copy
Resize options:
Remove free blocks between parttions

Mark the checkbox to peoportionally change the size of panttions while keeping ther

relative order intact
Tip: This can be very convenient when migrating to a larger hard disk

8. On the Revise Copy Results page review all parameters of the operation.

Basic Hard Disk 1 (VMware, VMware Vitual S SCS1 Disk Dev)
@) Local Disk (E9) | ©) Local Dis... e I @) (Unallo_._
34 GB FATAZ 24GBNTFS 14G 22GB

Basic Hard Disk 3 (VMware, VMware Vitual S SCSI Disk Dev)
@) Local Disk (*) P @ local D g)."l .(_))(Undloal..
173 GB FAT3? 1205GB NTFS 712 134 6GB

Proportional resize - the copy will take 500 GB (100 % of tarpet disk space)
Min Copy Size: 627.5MB |
L“ Select the range of the disk space that wil be occupied on the destination disk with copied ]

U Max Copy Size: 500GB

partitions.

9. Complete the wizard and then apply the pending changes.
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@ er=)
Apply pending changes 7

[~ Da not show this message again Yes I Mo

10. When copying is completed, shut down the computer.
11. Disconnect (physically) the source hard disk.

12. Boot the computer from the destination hard disk.

Hard Disk Optimization
To defragment an NTFS or FAT partition, please do the following:

Launcher

You must have administrator’s privileges to accomplish defragmentation of the system
partition.

1. Click the Partition Manager button and then Partition Manager in the Express Launcher.

2. Inthe main window, select a partition you want to defragment on the Disk Map.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Vista (C) New Volume (F:)
158.7GB NTFS [ 341.2GB NTFS
Total size: 158.7
Basic Hard Disk 1 (VMware, \{U‘f:;sl'li 16588 7 6B IS Dk Dev)
Local Disk (E) frec 47368 loated)

268 3GB NTFS . 231.6GE

3. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right click of the
mouse button) and then selecting the menu item: Defragment Partition...

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

Vista (C)) Y L
158.7GB NTFS n Analyze Fragmentation

) Defragment Partition...
Basic Hard Disk 1 (VM A Dev)
’ Defragment MFT...

;:::G?:(T:? & Compact MFT...
Test Surface...
i ;\‘\_; Check File System Integrity Lt
B NS B FAT ™~ Lo B3

Properties...

«

4. Inthe opened dialog define settings of the operation. To improve the performance we recommend you to mark
the Do not save content of the Pagefile.sys or (and) Hiberfile.sys checkbox as these files are only needed for
the current Windows session.
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Defragment volume (C:)?
1 Defragmantation may improve pedomancs of your system . For lockoad

wplumes, howewer, this operation will requins the: sjysiem restan

Drectories placement

Put dirsctonas Leave as i ]
Sort options

Sont by size Do ot sort [=]

Sort by modfication time: | Do not sort L]

The Defragment Partition dialog offers a number of additional parameters that can also be
of help. However here we pay attention to the most relevant to fulfill our task.

5. Start the operation by clicking the Yes button.

Troubleshooter

Here you can find answers to the most frequently asked questions that might arise while using the program.
1. Itryto run an operation, but the program claims my partition is in use and suggests restarting the computer.

There are a number of operations that cannot be performed while your partition is in use (or locked in other
words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-
up mode.

2. lrun an operation and restart the machine as required, but it just boots back into Windows without
accomplishing the operation.

Please run 'chkdsk /f' for the partition in question.
3. | cannot create a new partition on the disk.
There can be a number of reasons for that:

e The program cannot create a new partition on a dynamic disk, but only on a hard disk that uses the DOS
partitioning scheme.

e According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot
be created:

- Two Extended Partitions on one hard disk;
- Five or more Primary partitions on one hard disk;
- If there is an Extended Partition on the disk, only three Primary partitions are allowed.

e The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert
a free space on an existing partition to a new partition.

4. | cannot copy a partition.

There can be a number of reasons for that:
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- The source or target disk you select is a dynamic disk;
- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.

5. | need to copy a partition. But when selecting a place where to make a copy, | always get a crossed circle sign no
matter which partition is selected.

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free
space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. | cannot do anything with my USB flash drive. | get a crossed circle sign when trying to select any area on it.

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the
issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a
standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could
not be started for processed volume".

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot
Processing mode instead.

9. | cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the
following error: Hard Disk management, Error Code 0x1100a. What is wrong here?

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this
service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My
Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to
start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, | get an error: error code
0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, | get the following error: error code
0x12016 "VSS: can't read volume data”

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, | get the following error: "i/o error" or "can't open/create file"
Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, | get the following error: "Can't restore to current selection" or

"Archive does not fit"
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Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa.
14. | set up a timetable for a task, but it fails to execute.
There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call
Notepad through scheduling);

- You don’t have permission to write to the selected backup destination.

Glossary
Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary
partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term backup originates from the time when the best way to protect valuable information was to store it in form of
archives on external media. It's become now a general notion to mean making duplications of data for protection
purposes.

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will
be able to restore the data from these archives without having to run the program, but by simply booting from these
CD/DVDs.

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows
organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the
more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based
on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of
fragmentation on the volume. A cluster is also called an allocation unit.

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is
used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

File System Metadata. The servicing structures of a file system, which contain information about allocating files and
directories, security information etc, are named the file system metadata. It is invisible for users and regular
applications because its accidental modification usually makes a partition unusable.

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are
divided into tracks (or heads), and tracks are divided into sectors.

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk
Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an
essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors
are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can
additionally emulate the C/H/S geometry.
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Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an
operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by
XOR-ing the partition ID with a 0x10 hexadecimal value.

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It
contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a
FAT file system.

MBR & 1st track of the hard disk is the Oth sector of the disk. MBR (Master Boot Record) contains important
information about the disk layout:

- The used partitioning scheme;

- The starting records of the Partition Table;

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).
Generally, the Oth sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed
to use the entire Oth track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot
Manager are located in the Oth track.

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect
partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot
sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK
utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively
large amount of text in multiple languages.

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions
located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It
was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible
computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX
mainframe systems. Veritas Executive accommaodates a simplified version of LDM to the Windows 2000 operating
system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new
Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition,
most hard disk utilities do not support it as well.
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Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or
recovery purposes.

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file
systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12
and FAT16 file systems.

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number
represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is
initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows
NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when
the partition is formatted. It does not play an important role for most operating systems and software as well.
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